To our customers,

Old Company Name in Catalogs and Other Documents

On April 1%, 2010, NEC Electronics Corporation merged with Renesas Technology
Corporation, and Renesas Electronics Corporation took over all the business of both
companies. Therefore, although the old company name remains in this document, it is a valid
Renesas Electronics document. We appreciate your understanding.

Renesas Electronics website: http://www.renesas.com

April 1%, 2010
Renesas Electronics Corporation

Issued by: Renesas Electronics Corporation (http://www.renesas.com)

Send any inquiries to http://www.renesas.com/inquiry.
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Notice

All information included in this document is current as of the date this document isissued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful atention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.

Y ou should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. Y ou are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any lossesincurred by
you or third parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. Y ou should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the devel opment of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errorsin or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific”. The recommended applications for each Renesas Electronics product depends on the product’ s quality grade, as
indicated below. Y ou must check the quality grade of each Renesas Electronics product before using it in aparticular
application. You may not use any Renesas Electronics product for any application categorized as “ Specific” without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not bein any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as “ Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is “ Standard” unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances, machine tools; personal electronic equipment; and industrial robots.
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.
“Specific”: Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or heathcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose adirect threat to human life.
Y ou should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especialy with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physica injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as aresult of your noncompliance with
applicable laws and regulations.

This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sdes office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics’ as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.




To dll our customers

Regarding the change of names mentioned in the document, such as Hitachi
Electric and Hitachi XX, to Renesas Technology Corp.

The semiconductor operations of Mitsubishi Electric and Hitachi were transferred to Renesas
Technology Corporation on April 1st 2003. These operations include microcomputer, logic, analog
and discrete devices, and memory chips other than DRAMSs (flash memory, SRAMs €tc.)
Accordingly, although Hitachi, Hitachi, Ltd., Hitachi Semiconductors, and other Hitachi brand
names are mentioned in the document, these names have in fact all been changed to Renesas
Technology Corp. Thank you for your understanding. Except for our corporate trademark, logo and
corporate statement, no changes whatsoever have been made to the contents of the document, and
these changes do not constitute any alteration to the contents of the document itself.

Renesas Technology Home Page: http://www.renesas.com

Renesas Technology Corp.
Customer Support Dept.
April 1, 2003
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Cautions

Keep safety first in your circuit designs!

1

Renesas Technology Corporation puts the maximum effort into making semiconductor products better
and more reliable, but there is aways the possibility that trouble may occur with them. Trouble with
semiconductors may lead to personal injury, fire or property damage.

Remember to give due consideration to safety when making your circuit designs, with appropriate
measures such as (i) placement of substitutive, auxiliary circuits, (ii) use of nonflammable materia or
(iii) prevention against any malfunction or mishap.

Notes regarding these materials

1

These materials are intended as areference to assist our customersin the selection of the Renesas
Technology Corporation product best suited to the customer's application; they do not convey any
license under any intellectual property rights, or any other rights, belonging to Renesas Technology
Corporation or athird party.

Renesas Technology Corporation assumes no responsibility for any damage, or infringement of any
third-party's rights, originating in the use of any product data, diagrams, charts, programs, agorithms, or
circuit application examples contained in these materials.

All information contained in these materials, including product data, diagrams, charts, programs and
algorithms represents information on products at the time of publication of these materials, and are
subject to change by Renesas Technology Corporation without notice due to product improvements or
other reasons. It istherefore recommended that customers contact Renesas Technology Corporation
or an authorized Renesas Technology Corporation product distributor for the latest product information
before purchasing a product listed herein.

The information described here may contain technical inaccuracies or typographical errors.

Renesas Technology Corporation assumes no responsibility for any damage, liability, or other loss
rising from these inaccuracies or errors.

Please also pay attention to information published by Renesas Technology Corporation by various
means, including the Renesas Technology Corporation Semiconductor home page
(http://www.renesas.com).

When using any or al of the information contained in these materials, including product data, diagrams,
charts, programs, and algorithms, please be sure to evaluate al information as atotal system before
making afinal decision on the applicability of the information and products. Renesas Technology
Corporation assumes no responsibility for any damage, liability or other loss resulting from the
information contained herein.

Renesas Technology Corporation semiconductors are not designed or manufactured for usein a device
or system that is used under circumstances in which human lifeis potentially at stake. Please contact
Renesas Technology Corporation or an authorized Renesas Technology Corporation product distributor
when considering the use of a product contained herein for any specific purposes, such as apparatus or
systems for transportation, vehicular, medical, aerospace, nuclear, or undersea repeater use.

The prior written approval of Renesas Technology Corporation is hecessary to reprint or reproduce in
whole or in part these materials.

If these products or technologies are subject to the Japanese export control restrictions, they must be
exported under alicense from the Japanese government and cannot be imported into a country other
than the approved destination.

Any diversion or reexport contrary to the export control laws and regul ations of Japan and/or the
country of destination is prohibited.

Please contact Renesas Technology Corporation for further details on these materials or the products
contained therein.
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Cautions

. Hitachi neither warrants nor grants licenses of any rights of Hitachi’s or any third party’s
patent, copyright, trademark, or other intellectual property rights for information contained in
this document. Hitachi bears no responsibility for problems that may arise with third party’s
rights, including intellectual property rights, in connection with use of the information
contained in this document.

. Products and product specifications may be subject to change without notice. Confirm that you
have received the latest product standards or specifications before final design, purchase or
use.

. Hitachi makes every attempt to ensure that its products are of high quality and reliability.
However, contact Hitachi’ s sales office before using the product in an application that
demands especially high quality and reliability or where its failure or malfunction may directly
threaten human life or cause risk of bodily injury, such as aerospace, aeronautics, nuclear
power, combustion control, transportation, traffic, safety equipment or medical equipment for
life support.

. Design your application so that the product is used within the ranges guaranteed by Hitachi
particularly for maximum rating, operating supply voltage range, heat radiation characteristics,
installation conditions and other characteristics. Hitachi bears no responsibility for failure or
damage when used beyond the guaranteed ranges. Even within the guaranteed ranges,
consider normally foreseeable failure rates or failure modes in semiconductor devices and
employ systemic measures such as fail-safes, so that the equipment incorporating Hitachi
product does not cause bodily injury, fire or other consequential damage due to operation of
the Hitachi product.

. Thisproduct is not designed to be radiation resistant.

. No oneis permitted to reproduce or duplicate, in any form, the whole or part of this document
without written approval from Hitachi.

. Contact Hitachi’ s sales office for any questions regarding this document or Hitachi
semiconductor products.




IMPORTANT INFORMATION
READ FIRST

* READ thisuser's manual before using thisemulator product.

» KEEP the user's manual handy for futurereference.

Do not attempt to use the emulator product until you fully under stand its mechanism.

Emulator Product:

Throughout this document, the term "emulator product” shall be defined as the following
products produced only by Hitachi, Ltd. excluding all subsidiary products.

e Emulator
» User system interface cable

The user system or a host computer is not included in this definition.

Purpose of the Emulator Product:

This emulator product is a software and hardware development tool for systems employing the
Hitachi microcomputer. This emulator product must only be used for the above purpose.

Limited Applications:

This emulator product is not authorized for usein MEDICAL, atomic energy, aeronautical or
space technology applications without consent of the appropriate officer of a Hitachi sales
company. Such use includes, but is not limited to, usein life support systems. Buyers of this
emulator product must notify the relevant Hitachi sales offices before planning to use the product
in such applications.

Improvement Policy:

Hitachi, Ltd. (including its subsidiaries, hereafter collectively referred to as Hitachi) pursues a
policy of continuing improvement in design, performance, and safety of the emulator product.
Hitachi reserves the right to change, wholly or partialy, the specifications, design, user's manual,
and other documentation at any time without notice.

Target User of the Emulator Product:

This emulator product should only be used by those who have carefully read and thoroughly
understood the information and restrictions contained in the user's manual. Do not attempt to use
the emulator product until you fully understand its mechanism.

It is highly recommended that first-time users be instructed by users that are well versed in the
operation of the emulator product.

RENESAS



LIMITED WARRANTY

Hitachi warrants its emulator products to be manufactured in
accordance with published specifications and free from defectsin
material and/or workmanship. Hitachi, at its option, will replace any
emulator products returned intact to the factory, transportation charges
prepaid, which Hitachi, upon inspection, shall determine to be defective
in material and/or workmanship. The foregoing shall constitute the sole
remedy for any breach of Hitachi's warranty. See the Hitachi warranty
booklet for details on the warranty period. This warranty extends only
to you, the original Purchaser. It is not transferable to anyone who
subsequently purchases the emulator product from you. Hitachi is not
liable for any claim made by athird party or made by you for athird

party.
DISCLAIMER

HITACHI MAKES NO WARRANTIES, EITHER EXPRESS OR
IMPLIED, ORAL OR WRITTEN, EXCEPT AS PROVIDED
HEREIN, INCLUDING WITHOUT LIMITATION THEREOF,
WARRANTIESASTO MARKETABILITY, MERCHANTABILITY,
FITNESS FOR ANY PARTICULAR PURPOSE OR USE, OR
AGAINST INFRINGEMENT OF ANY PATENT. IN NO EVENT
SHALL HITACHI BE LIABLE FOR ANY DIRECT, INCIDENTAL
OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR
LOSSES OR EXPENSES RESULTING FROM ANY DEFECTIVE
EMULATOR PRODUCT, THE USE OF ANY EMULATOR
PRODUCT, OR ITSDOCUMENTATION, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES. EXCEPT AS
EXPRESSLY STATED OTHERWISE IN THISWARRANTY,
THISEMULATOR PRODUCT ISSOLD "ASIS", AND YOU
MUST ASSUME ALL RISK FOR THE USE AND RESULTS
OBTAINED FROM THE EMULATOR PRODUCT.

RENESAS




State Law:

Some states do not allow the exclusion or limitation of implied warranties or liability for
incidental or consequential damages, so the above limitation or exclusion may not apply to you.
Thiswarranty gives you specific legal rights, and you may have other rights which may vary from
state to state.

The Warranty is Void in the Following Cases:

Hitachi shall have no liability or legal responsibility for any problems caused by misuse, abuse,
misapplication, neglect, improper handling, installation, repair or modifications of the emulator
product without Hitachi's prior written consent or any problems caused by the user system.

All Rights Reserved:

This user's manual and emulator product are copyrighted and all rights are reserved by Hitachi.
No part of thisuser's manual, all or part, may be reproduced or duplicated in any form, in hard-
copy or machine-readable form, by any means available without Hitachi's prior written consent.
Other Important Things to Keep in Mind:

1. Circuitry and other examples described herein are meant merely to indicate the characteristics
and performance of Hitachi's semiconductor products. Hitachi assumes no responsibility for
any intellectual property claims or other problems that may result from applications based on
the examples described herein.

2. Nolicenseisgranted by implication or otherwise under any patents or other rights of any third
party or Hitachi.
Figures:

Some figuresin this user's manual may show items different from your actual system.

Device names:

Sections 1 to 5 in this user’s manual use SHxxxx as an example of the device names.

Limited Anticipation of Danger:

Hitachi cannot anticipate every possible circumstance that might involve a potential hazard.
The warnings in this user's manual and on the emulator product are therefore not all inclusive.
Therefore, you must use the emulator product safely at your own risk.

11
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SAFETY PAGE
READ FIRST

* READ thisuser's manual before using this emulator product.

» KEEP the user's manual handy for futurereference.

Do not attempt to use the emulator product until you fully under stand its mechanism.

DEFINITION OF SIGNAL WORDS

A This is the safety alert symbol. Itis used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

A DANGER DANGER indicates an imminently hazardous situation which, if not

avoided, will result in death or serious injury.

A WARNING WARNING indicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.
A CAUTION CAUTION indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury.
CAUTION CAUTION used without the safety alert symbol indicates a

potentially hazardous situation which, if not avoided, may result
in property damage.

NOT E emphasizes essential information.

RENESAS



A WARNING

Observe the precautions listed below. Failure to do so

will result in a FIRE HAZARD and will damage the user
system and the emulator product or will result in

PERSONAL INJURY. The USER PROGRAM will be
LOST.

1. Do not repair or remodel the emulator product by

2.

3.

4.

yourself for electric shock prevention and quality
assurance.

Always switch OFF the host computer and user system

before connecting or disconnecting any CABLES or
PARTS.

Connect the connectors in the user system and in the
user interface cable by confirming the correct direction.

If the PCl interface board for the E6000 or EB000 emulator
(HS6000EIC01H) and the E10A emulator PCI card are
mounted on the same host computer, the connectors
may be illegally connected.

RENESAS




Warnings on Emulator Usage

Be sure to read and understand the warnings below before using this emulator. Note that these are
the main warnings, not the complete list.

A WARNING

Always switch OFF the host computer and user system
before connecting or disconnecting any CABLES or PARTS.

Failure to do so will result in a FIRE HAZARD and will
damage the user system and the emulator product or will
result in PERSONAL INJURY. The USER PROGRAM will be
LOST.

CAUTION

Place the host computer and user system so that no
cable is bent or twisted. A bent or twisted cable will impose
stress on the user interface leading to connection or contact
failure.

Make sure that the host computer and the user system
are placed in a secure position so that they do not move
during use nor impose stress on the user interface.

Vi
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Preface

Thank you for purchasing the E10A emulator.

CAUTION

READ section 2, Preparation before Use, of this User’s
Manual before using the emulator product. Incorrect
operation will damage the user system and the emulator
product.

Thisemulator is an efficient development tool for software and hardware of user systems based on
Hitachi’ s original microprocessor. The emulator operates using the Hitachi debugging interface
(hereafter referred to asthe HDI), which is the interface program that runs on Microsoft”
Windows’ 98, Microsoft” Windows’Me, Microsoft” Windows 2000, Microsoft” Windows NT*,
or Microsoft™ Windows' X P operating system.

This manual describes the functions and operating procedures of the E10A emulator. Sections 1 to
5 describe common features of all types of E10A emulators. Section 6 describes supplementsto
the E10A emulator. Read section 1.1, Warnings, carefully before using the emulator.

This manual consists of six sections. The information contained in each section is summarized
below:

» Section 1, Overview, gives the emulator overview.

» Section 2, Preparation before Use, givesinstructions for first-time users, such as preparation
before use and system connection.

e Section 3, Tutorial, describes HDI operating examples and functions.

» Section 4, Descriptions of Windows, describes HDI windows for operating the emulator.

e Section 5, Command-line Functions describes how to input HDI commands and command
types.

» Section 6, SHxxxx E10A Emulator Specifications describes the detailed specifications and the
features of the E10A emulator for each device. Section 7 describes the important information
of the E10A emulator according to emulator products. Read these sections before using the
E10A emulator.

The HDI ingtallation disks are provided by the CD-R. Refer to the descriptions in the manuals of
the host computer or operating system.

RENESAS



Related Manuals:

» SuperHO RISC Engine C/C++ Compiler, Assembler, Optimizing Linkage Editor User's

Manual

» Hitachi Debugging Interface User's Manual
» Hardware Manual for each device
*  Programming Manual for each device

Notes. 1.

4,

IBM PC isaregistered trademark of International Business Machines
Corporation.

Microsoft®, Windows®, and Windows NT® are registered trademarks of
Microsoft Corporation in the United States and/or other countries.

Microsoft” Windows® 98 operating system isreferred to as Windows® 98 in this
user'smanual.

Microsoft® Windows® Millennium Edition operating system isreferred to as
Windows® Mein this user's manual.

Microsoft” Windows® 2000 oper ating system isreferred to as Windows® 2000 in
thisuser'smanual.

Microsoft® Windows® X P operating system isreferred to as Windows® XP in
thisuser'smanual.

Adobe, Acrobat, and Acrobat Reader areregistered trademarks of Adobe
Systems I ncor por ated.

Other brand and product names areregistered trademarks of each company.
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Section 1 Overview

The E10A emulator (hereafter referred to as the emulator) is a software and hardware
development support tool for application systems using the microprocessor developed by Hitachi,
Ltd.

The PCMCIA card emulator or PCI card emulator (hereafter referred to as the card emulator),
which isthe main unit of the emulator, is connected, through the Hitachi-UDI (user debug
interface) port”, to the user system. The user system can be debugged under the conditions similar
to the actual application conditions. The emulator enables debugging anywhere indoors or out.
The host computer for controlling the emulator must be an IBM PC compatible machine with a
PCMCIA typell or PCI dot.

Figures 1.1 and 1.2 show the system configuration using the emulator.

Note: The Hitachi-UDI isan interface compatible with the Joint Test Action Group
(JTAG) specifications.

Host computer (PC with PCMCIA TYPE Il slot)

PCMCIA card emulator

oancH
=
/f/ﬁff*f//”” i User system interface cable
(a — 77 —
pa—e

| \

-
Insert into the PCMCIA TYPE Il slot

Connect to the Hitachi-UDI port connector

User system

Figurel.l System Configuration with the Emulator (PCMCIA Card Emulator Used)
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User system interface cable

PCl card emulator

SHxxxx

Insert into
the PCI slot

User system

Host computer

Figurel.2 System Configuration with the Emulator (PCI Card Emulator Used)

The emulator provides the following features:

Excellent cost-performance card emulator
Compactness and low price are implemented using the PCMCIA interface or the PCl interface.
Realtime emulation

Realtime emulation of the user system is enabled at the maximum operating frequency of the
CPU.

Excellent operability

Using the Hitachi Debugging Interface (HDI) on the Microsoft® Windows” 98, Microsoft®
Windows” Me, Microsoft® Windows® 2000, and Microsoft® Windows NT® operating systems
enables user program debugging using a pointing device such asamouse. The HDI enables
high-speed downloading of load modulefiles.

Various debugging functions

Various break and trace functions enabl e efficient debugging. Breakpoints and break
conditions can be set by the specific window, trace information can be displayed on awindow,
and command-line functions can be used.

Memory access during emulation

During emulation, the memory contents can be read and modified.

Debugging of the user system in the final development stage

The user system can be debugged under conditions similar to the actual application conditions.
Compact debugging environment

When the card emulator specific to the PCMCIA interface is used, alaptop computer can be
used as a host computer, creating a debugging environment in any place.
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* AUD trace function*
The AUD trace function enables realtime trace.

Note: The AUD isan abbreviation of the Advanced User Debugger. Support for the AUD varies
with the product.

1.1 Warnings

CAUTION

READ the following warnings before using the emulator
product. Incorrect operation will damage the user system and
the emulator product. The USER PROGRAM will be LOST.

1. Check all components against the component list after unpacking the emulator.
2. Never place heavy objects on the casing.

3. Protect the emulator from excessive impacts and stresses. For details, refer to section 1.2,
Environmental Conditions.

4. Do not insert the emulator into any slot (PCMCIA TYPE Il dot or PCI slot) other than the
specified one.
5. When moving the host computer or user system, take care not to vibrate or damageit.

6. After connecting the cable, check that it is connected correctly. For details, refer to section 2,
Preparation before Use.

7. Supply power to the connected equipment after connecting all cables. Cables must not be
connected or removed while the power ison.
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1.2 Environmental Conditions

CAUTION

Observe the conditions listed in tables 1.1 and 1.2 when
using the emulator. Failure to do so will cause illegal
operation in the user system, the emulator product, and the
user program.

Table1.1 Environmental Conditions

Item Specifications

Temperature Operating: +10°C to +35°C
Storage: —10°C to +50°C

Humidity Operating: 35% RH to 80% RH, no condensation
Storage: 35% RH to 80% RH, no condensation
Vibration Operating: 2.45 m/s* max.
Storage: 4.9 m/s” max.

Transportation: 14.7 m/s’ max.

Ambient gases  No corrosive gases may be present

Table 1.2 lists the acceptabl e operating environments.
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Table1.2 Operating Environments

Item

Description

Host computer

Built-in Pentium or higher-performance CPU (200 MHz or higher
recommended); IBM PC or compatible machine with the PCMCIA
TYPE Il slot or the PCI slot.

oS Windows® 98, Windows® Me, Windows® 2000, or Windows NT®
Minimum memory 32 Mbytes or more (double of the load module size recommended)
capacity

Hard-disk capacity

Installation disk capacity: 10 Mbytes or more. (Prepare an area at
least double the memory capacity (four-times or more recommended)
as the swap area.)

Pointing device such as
mouse

Connectable to the host computer; compatible with Windows® 98,
Windows® Me, Windows® 2000, and Windows NT®.

Power voltage

5.0+£025V

Current consumption

HSxxxxKCMO1H: 110 mA (max)
HSxxxxKCMO02H: 230 mA (max)
HSxxxxKCIO1H: 340 mA (max)
HSxxxxKCI02H: 600 mA (max)

CD-ROM drive

Required to install the HDI for the emulator or refer to the emulator
user’'s manual.

RENESAS



13 Components

Check all the components unpacking. For details on the EI0A emulator components, refer to
section 6.1, Components of the Emulator. |f the components are not complete, contact a Hitachi

sales agency.
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Section 2 Preparation before Use

2.1 Emulator Preparation

A WARNING

READ the reference sections shaded in figure 2.1 before
using the emulator product. Incorrect operation will damage
the user system and the emulator product. The USER
PROGRAM will be LOST.

Unpack the emulator and prepare it for use as follows:

Reference
| Unpack the emulator | Component list
| Check the components against the component list |
| When the emulator
is used first.
Set up the emulator Section 2
- Install the HDI
- Insert the card emulator
I
| Start the HDI | Section 3

I When the emulator
| Turn on the user system | is used for second

| time or later.
| Input the user system reset signal |

Figure2.1 Emulator Preparation Flow Chart
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2.2 HDI Installation

When the CD-R isinserted in the host computer’s CD-ROM drive, the HDI installation wizard is
automatically activated (holding the Shift key down while the CD-R isinserted cancels this
automatic activation). To run the installation wizard when it has not been automatically activated,
execute Setup.exe from the root directory of the CD-R.

Follow the cues given by the installation wizard to install the HDI.

Since hardware settings are also made during installation, the installation procedure differs
according to the operating system or interface (PCI or PCMCIA) being used. Follow the
installation steps carefully according to the environment you are using.

221  Installing under Windows’98 and Windows’Me Oper ating Systems

(1) When the emulator isa PCI card:
1. Install the HDI (when the component type has to be selected during installation, be sure to
select [PCI Card Driver]).
2. Shut the operating system down and turn off the power to the host computer.
3. Insert the PCl-card emulator in aslot on the host computer. Refer to section 2.3,
Connecting the Card Emulator to the Host Computer.
4. Restart the host computer. The hardware is now recognized and the driver is
automatically installed.*
(2) When the emulator isa PCMCIA card:
1. Install the HDI (when the component type has to be selected during installation, be sure to
select [PC Card Driver (PCMCIA))).
2. Insert the PCMCIA-card emulator in the host computer’s slot. Refer to section 2.3,
Connecting the Card Emulator to the Host Computer.
3. Thehardware is now recognized and the driver is automatically installed.*

Note:  When [Add New Hardware Wizard] is displayed, select the [Search for the best driver for
your device. (Recommended)] radio button and then the [ Specify alocation] check box to
select the path to be searched for drivers. The location must be specified according to the
emulator type, asindicated below:

When using the PCl-card emulator: <Drive>:\DRIVERS\PCI\95
When using the PCM CIA-card emulator: <Drive>:\DRIVERS\PCM CIA\95
(<Drive> isthe CD-ROM drive name.)
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222 Installing under Windows NT”4.0 Oper ating System

(1) When the emulator isa PCI card:
1. Shut the operating system down and turn off the power to the host computer.
2. Insert the PCl-card emulator in aslot on the host computer. Refer to section 2.3,
Connecting the Card Emulator to the Host Computer.
3. Start the host computer and log-on with an administrator-level user name.
4. Install the HDI. (For a component, be sure to select [PCI Card Driver]. Thereisacheck
box for selecting the type name of the product under the [PCI Card Driver] component. Select
the appropriate type name. |If the correct name is not selected, the correct driver will not be
installed, and the emulator will not operate.)
5. Restart the host computer.

(2) When the emulator isa PCMCIA card:
1. Shut the operating system down and turn off the power to the host computer.
2. Insert the PCMCIA-card emulator in the host computer’ sslot. Refer to section 2.3,
Connecting the Card Emulator to the Host Computer.
3. Start the host computer and log-on with an administrator-level user name.
4. During HDI installation, the setting value should be checked beforehand because inquiries
are made about the resource used by the PCM CIA-card emulator.
Start the [Start] menu -> [Programs] -> [Administrative Tools (Common)] -> [Windows NT
Diagnostics], check the status of the IRQ, 1/0 port, and memory from the resource panel, and
determine the setting values that do not conflict with other devices. (The following resources
are used: IRQ: one channel, I/O port: H'F byte, and memory: H’ 4000 byte.)
5. Install the HDI. (For a component, be sure to select [PC Card Driver (PCMCIA)]. Thereis
acheck box for selecting the type name of each product under the [PC Card Driver
(PCMCIA)] component. Select the appropriate type name. If the correct name is not selected,
the correct driver will not be installed and the emulator will not operate.)

6. Restart the host computer.

Notes: 1. For the SH7729, SH7729R, and SH7622 E10A emulators, there is a check box for
selecting the MODEL name that appears on the component list. Select the correct type
name.

2. Thedriver that has been selected in the [ Drivers] component starts after the host
computer isinitiated. If the host computer isinitiated with the card disconnected or
with the incorrect driver installed, the driver cannot initiate and the service control
manager informs the system of an error. This, however, is not a problem.
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2.2

3

Installing under Windows’2000 Oper ating System

(1) When the emulator isa PCI card:

A w DN PR

L og-on with an administrator-level user name.

Install the HDI. (When a component is selected, be sure to select [PCI Card Driver].)
Shut the operating system down and turn off the power to the host computer.

Insert the PCl-card emulator in aslot on the host computer. Refer to section 2.3,
Connecting the Card Emulator to the Host Computer.

Restart the host computer and log-on with an administrator-level user name. The
hardware is now recognized and the driver is automatically installed.*

(2) When the emulator isaPCMCIA card:

Note:

10

1
2.

L og-on with an administrator-level user name.

Install the HDI. (When a component is selected, be sure to select [PC Card Driver
(PCMCIA)].)

Insert the PCMCIA-card emulator in the host computer’s slot. Refer to section 2.3,
Connecting the Card Emulator to the Host Computer.

The hardware is now recognized and the driver is automatically installed.*

When [Found New Hardware Wizard] is displayed, select the [Search for a suitable driver
for my device (recommended).] radio button and then the [ Specify alocation] check box
to select the path to be searched for drivers. The location must be specified according to
the emulator type, as indicated below:

When using the PCI-card emulator: <Drive>:\DRIVERS\PCI\2000

When using the PCM CIA-card emulator: <Drive>:\DRIVERS\PCM CIA\2000

(<Drive> isthe CD-ROM drive hame.)
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2.3 Connecting the Card Emulator to the Host Computer

Insert the card emulator, according to itstype, inaPCMCIA TYPE Il dot or PCI slot on the host
computer (figures 2.2 and 2.3).

Note: When using Windows 98, Windows’Me, or Windows§ 2000, be sureto install the HDI
before putting the card emulator in place.

Host computer (PC with the PCMCIA TYPE Il slot)

PCMCIA card emulator

f 7777 77777
7 ﬁ/f//ﬂ

Insert into the PCMCIA TYPE Il slot

Figure2.2 Insertingthe PCMCIA Card Emulator in the Host Computer’s Slot

PCIl card emulator

-

-
1
- % Insert into the PCI slot

s SRR %\\

Host computer

Figure2.3 Inserting the PCl Card Emulator in the Host Computer’s Slot

Use the procedure, described in section 2.4, to connect the emulator to the user system with the
user system interface cable, or to disconnect them when moving the emulator or the user system.

11
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A WARNING

When inserting the PCIl-card emulator, note the following.
Failure to do so will damage the host computer.

1. Turn off the host computer.
2. Insert the emulator into the PCI slot in parallel.

3. Screw in the emulator after checking the connector and
cable positions.

2.4 Connecting the Card Emulator to the User System

(1) The Hitachi-UDI port connector must be installed to the user system. Table 2.1 showsthe
recommended Hitachi-UDI port connector for the emulator.

Table2.1 Recommended Hitachi-UDI Port Connector

Connector Type Number Manufacturer Specifications
14-pin connector  2514-6002 Minnesota Mining & 14-pin straight type
Manufacturing Ltd.
36-pin connector DX10M-36S Hirose Electric Co., Ltd. Screw type
DX10M-36SE, Lock-pin type

DX10GM-36SE

Note: When the 14-pin connector isused, do not install any componentswithin 3 mm of the
Hitachi-UDI port connector.
When the 36-pin connector isused, do not connect other signal linesto the Hitachi-
UDI port connector.

(2) Note that the TDO signal of the user system interface cable connector must be connected to
the TDI pin of the Hitachi-UDI port connector and the TDI signal of the user system interface
cable connector must be connected to the TDO pin of the Hitachi-UDI port connector. Section
6.2 shows the pin arrangement of the Hitachi-UDI port connector.

(3) Figure 2.4 shows how to connect the user system interface cable to the user system when the
14-pin straight type connector is used. Connect the ground line of the cable to the user system
ground. The end of the ground line has a hole having a diameter of 3 mm, and therefore,
when the ground line is screwed to the user system, the screw diameter must be 3 mm.

12
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User system interface cable

GND line
Hitachi-UDI port

connector

User system GND
connection

) User system
Pin 1

Figure2.4 Connecting the User System Interface Cable to the User System
when the 14-pin Straight Type Connector is Used

Notes: 1. Toconnect the signalsoutput from the Hitachi-UDI port connector, refer to
the device pin alignment.

2. Toremovetheuser system interface cable from the user system, pull the tab
on the connector upward.

3. Therange of frequenciesthat the Hitachi-UDI operates at is different
according to the devicesused. For details, refer to section 6.5.4, Notes on
Using the JTAG Clock (TCK) and AUD Clock (AUDCK).

4, Connect the Hitachi-UDI signalsfrom the Hitachi-UDI port connector directly
to thedevice.

5. When developing user systems, do not connect the TDI and TDO signals of the

device to the boundary scan loop, or separate them by using a switch (figure
2.5).

13
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Hitachi-UDI SHx0

port

] TDI
TDO Hitachi-UDI

JTAG IC IC “wa IC

port

[ __TDIl _{TDO TDI DQ, .. TDI TDO
TAP TAP TAP

Boundary scan loop

User system

TDI: Test data input
TDO: Test data output
TAP: Test access port

14

Figure2.5 User System Example
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2.5 System Check

When the HDI program is executed, use the procedure below to check that the emulator is
operating correctly.

Check that the emulator card isinserted in the host computer’s slot.
Connect the user system interface cable to the connector of the card emulator.
Connect the user system interface cable to the Hitachi-UDI port connector.

Supply power to the host computer and select [HDI for E1I0A SHxxxx] -> [Hitachi Debugging
Interface] from the [Start] menu.

A w NP

.-'-‘-.c:u:essu:uries
Internet Explorer
Startllp

Jif& 145-D03 Prompt
(3 Windows E zplarer
B HO | for E104 SH

00
2
5
-
=

Figure2.6 [Start] Menu
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5. Select the setting to be used.

% Creste a pew session on

|SHxmmx E104 Emulator =]

{" Previous session file:

| -

Erowse.. |

16

Figure2.7 [Select Session] Dialog Box
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6. The[E10A Driver Details] dialog box is displayed. With the [Driver] combo box, select the
driver to connect the HDI with the emulator. [Interface] displays the interface name of the PC
interface board to be connected, and [Channel] displays the interface to which the board is
connected. Once the driver is selected in the [EL0A Driver Details] dialog box, this dialog

box is not displayed when the HDI is run next time. (This procedure will not be executed by
target devices.)

E10A Driver Details |

Driver. |E104 PC Card Driver <]
—Details
Interface: IF"C Card j
Channel: |E10A PC Card Interface -]

= Configuration

Configure... |

Help

Figure 2.8 [E10A Driver Details] Dialog Box
With the [Driver] combo box, select the driver to connect the HDI with the emulator.

[Interface] displays the interface name of the card emulator to be connected, and [Channel]
displays the interface to which the board is connected.

[Driver] combo box: Select [E1I0A PC Card Driver] to use the PCMCIA card emulator.
Select [EL0A PCI Card Driver] to use the PCI card emulator. For details,
refer to table 6.3 in section 6.5.1, Emulator Driver Selection.

[Interface] combo box: Select [PC Card] to use the PCMCIA card emulator.

[PCI] isdisplayed to use the PCI card emulator. (If the driver isnot
installed, the [PC Card] or [PCI] isnot displayed.)

Click the [Close] button.

17
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7. The HDI window is displayed, and the dialog box is displayed as shown in figure 2.9.

HDI =

& Fleaze, Rezet the user syztem and prezs <Enters Kep.

Figure2.9 Dialog Box of the RESET Signal Input Request M essage

8. Power on the user system.
9. Input the reset signal from the user system, and click the [OK] button.
10. When "Link Up" is displayed on the status bar, the HDI initiation is completed.

[ Lirk. up | | [MLIM | v

Figure2.10 [HDI] StatusBar

Notes: 1. When the HDI isnot linked up even if the above procedur e has been executed, the
driver will not be set correctly. Install driversprovided under the/DRIVERS
directory in the CD-R according to the screen instructions. For instructionson
how to check thedriver hasbeen correctly set, refer to the OS manual for your
host computer or thefollowing URL:
http://www.hitachi.co.j p/Sicd/English/Productsmicom/dev_env/tool/eml/el0a/
shelOaga.htm

2. If theuser system interface cableis disconnected to the Hitachi-UDI port
connector on the user system during user program execution, the following dialog
box will be displayed.

HDI =

& JTAG Connector dizconnected. Pleaze, connect and press <Enter: ke,

Figure2.11 [JTAG Connector Disconnected] Dialog Box
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3. If theemulator isnot initiated, the following dialog boxes shown in figures 2.12
through 2.16 will be displayed.
(a) If thefollowing dialog box isdisplayed, the power of the user system may not be
input or the RESET signal may not beinput to the device. Check theinput
circuitsfor the power of the user system and thereset pin.

HDI |
Can not find /RESET zignal.
Fleaze check /RESET and oo

Eetry | lgnaore |

Figure2.12 [Can not find /RESET signal] Dialog Box

(b) If thefollowing dialog box is displayed, check that the Hitachi-UDI port
connector on the user system iscorrectly connected.

HDI =

& Check: the connection between the H-UDI ping and the H-UD| port connectar.

Figure2.13 [Check the connection] Dialog Box

(c) If thefollowing dialog box isdisplayed, the device may not correctly operate.
Check if therearereasonsfor illegal device operation.

HDI

& COMMMUMICATION TIMESUT ERROR

Figure2.14 [COMMUNICATION TIMEOUT ERROR] Dialog Box
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HD

& INWALID ASERAM FIRKMWARE !

Figure2.15 [INVALID ASERAM FIRMWARE!] Dialog Box

HDI

& Error JTAG boot

Figure2.16 [Error JTAG boot] Dialog Box

4. If thedriver isnot correctly connected, the following dialog box will be displayed.

HDI

Unable to restore the previous driver settings
please choose another driver.

Figure2.17 [Unabletorestorethepreviousdriver settings] Dialog Box

The[E10A Driver Details] dialog box is displayed when the [OK] button isclicked.
Select the correct driver. For details, refer to section 6.5.1, Emulator Driver
Selection.

20
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2.6 EndingtheHDI
Exit the HDI by using the following procedure:

1. Select [Exit] from the [File] menu to end the HDI. When the [Exit HDI] dialog box is
displayed, click the [Yes] button.

HDI B |

Please confirm:
Exit HD!.

Figure 2.18 [Exit HDI] Dialog Box

2. Then, the [Save session] dialog box is displayed. If necessary, click the[Y es] button to save
session. After saving session, the HDI ends. If not necessary, click the [No] button to end the
HDI.

HDI K|

@ Save session

Mo | Cancel |

Figure2.19 [Save session] Dialog Box

3. Turnthe user system off.

21
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2.7 Uninstalling the HDI

Follow this procedure to remove the installed HDI from the user’ s host computer.

1.

Open [Add/Remove Programs Properties] from the control panel. Select the HDI program
from thelist and click the [Add/Remove...] button.

The setup program is executed again and the installed application can be changed, modified,
or removed. When the application is to be uninstalled, select removal.

CAUTION

A shared file may be detected while the program is being
removed. If another HDI may be using the shared file, do not
remove the file. When Microsoft” Windows NT"4.0 operating
system is used, the removal of the registry information on the
driver may be asked. If other HDI may use the target driver,
do not remove the registry information. If another HDI does
not start up after the removal process, re-install that HDI.

22
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28 CD-R

2.8.1 Configuration of the CD-R

Theroot directory of the CD-R contains a setup program for HDI installation. The folders contain

the files and programs listed below.
Table2.2 Contentsof the CD-R Directories

Directory Name  Contents

Description

Dlls Microsoft” runtime library A runtime library for the HDI. The version is
checked at installation and this library is
copied to the hard disk as part of the
installation process.

Drivers E10A emulator driver The E10A emulator drivers.

Help Online help for the E10A An online help file. This is copied to the hard

emulator disk as part of the installation process.

Manual E10A emulator manual Precautions on Using the E10A Emulator and
the user's manual. These are provided as
PDF files.

Pdf_read Adobe” Acrobat” Reader setup  Adobe” Acrobat” Reader is an application for

program displaying, viewing, and printing PDF files.

2.9 Support

Information on the latest version of the HDI and other supporting information for the emulator
can be found on the web site. Access the following URL.:

http://www.hitachi.co.jp/Sicd/English/Products/micom/dev_env/tool/eml/el0a/el0atop.htm

23
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Section 3 Tutoria

31 Introduction
The following describes the main functions of the HDI by using a tutorial program.

The tutorial program is based on the C program that sorts ten random data items in ascending or
descending order. Thetutorial program performs the following actions:

*  Themai n function generates random data to be sorted.
» Thesort function sortsthe generated random datain ascending order.
* The change function then sorts the datain descending order.

Thefilet ut ori al . ¢ contains source code for the tutorial program. Thefilet ut ori al . abs
isa compiled load module in the Dwarf2 format.

Table3.1isalist of the parts of the tutorial program and an outline of their configuration on the
hard disk.

Table3.1 Tutorial Program: Configuration and Parts

Item Contents

Workspace for HEW V1.2 [Installation directory]\tutorial\tutorial.hws

Load module [Installation directory]\tutorial\tutorial\Debug\tutorial.abs
Main program (source file) [Installation directory]\tutorial\tutorial\tutorial.c

Stack information file [Installation directory]\tutorial\tutorial\Debug\tutorial.sni

Use area 3 (CS3 space) as the operating environment. The MMU function is not used.

25
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Notes: 1. Operation of t ut ori al . abs isbigendian. For little-endian operation,
tutori al . abs must berecompiled. After recompilation, the addr esses may
differ from those given in this section.

2. Thisprogram was created by using Hitachi Embedded Workshop (her eafter
referred toasHEW) V1.2. Older versions of HEW will not open the workspace
included with the package, so create a new workspace in such situations.

3. Thisprogram was compiled without optimization for the SH2 CPU. If
recompiled with different settings, the addresses may differ from those given in
this section.

4. tutorial.abs isaload moduleinthe Dwarf2format. If aload moduleis
recreated in the Sysrof format, the amount of information displayed on the HDI
screen during the program’s execution will be reduced.

5. Thissection describes general usage examplesfor the emulator. For the

specifications of particular products, refer to section 6 or the online help file.
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3.2 Running the HDI

To run the HDI, select the [HDI for EI0A SHxxxx] -> [Hitachi Debugging Interface] from the
[Start] menu.

.-'-‘-.c:u:essu:uries
Internet Explorer
Startllp

Jif& 145-D03 Prompt
(3 Windows E zplarer
§= HD! for E104 SH

& Log Off asdminiztratar. .

Shut Do,
IR

00
2
5
-
=

Figure3.1 [Start] Menu

For the procedure of running the HDI, refer to section 2.5, System Check.
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3.3 [HDI] Window
EJ‘f!}‘ﬂt‘ﬁfﬂ&fh‘l_ﬂ_ﬂ!}o‘_ﬂfﬂ.“:?ff.i'r.?t’ tutorial - SH:zco:  E10A Emulator - [tutorial.c]
JJmh File Edit “iew Hun Memory Setup Window Help —|5|ﬂ‘
H amEE| sy FRAHLBTE0D||?
H R’::Io‘lil@ﬁlimuﬁ!@mﬂ@m& 2 AN
Line [iddress [EP [Label  [Source -
;& 30 Oz00006c _main void main(woid)
31
i || 32 long a[10]:
: =h 34 1grtlg:|.:| min, max:
35
i 36 0c00006e for({ i=0: i<10: i++ ){
e | 37 0000076 i = rand():
& | 38 0c00007e if(3 < 03{
34 Oc000082 i = -3
= | 40 h
fi : .
41 O0c000086 alil = 3:
4 |4z
o,
43 0z0000a2 =ort{al;
i |41 0cooonas nin = af07];
n 45 O=0000as mnax = a[9]:
46 O=0000b2 min = 0;
— | 47 0=0000b6 max = 0:
% 443 0=0000ba change(a);
49 O=0000z2 min = a[9]:
B || 50 0=0000c6 max = a[0];
51 0c0000ca while (1) _lﬂ
.| 1| | »
4% |For Help, press F1 [ HUM s

The key functions of the HDI are described in section 4, Descriptions of Windows. Numbersin

figure 3.2 indicate the following:

Figure3.2 [HDI] Window

1. Menu bar: Givesthe user accessto the HDI commands for using the HDI debugger.

2. Toolbar: Provides convenient buttons as shortcuts for the most frequently used menu

commands.

3. Source window: Displays the source program being debugged.

4. Status bar: Displays the status of the emulator, and progress information about

downloading.

5. [Help] button: Activates online help about any features of the HDI user interface.
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34 Setting up the Emulator

The clocks which are used for data communications must be set up on the emulator before the
program is downloaded.

» AUD clock
A clock used in acquiring AUD traces.
If its frequency is set too low, complete data may not be acquired during realtime tracing.
If the frequency is set too high, the upper limit for the device’'s AUD clock may be exceeded.
The AUD clock is only needed for emulators that have an AUD trace function.

» JTAG clock (TCK)
A communication clock for downloading data to the emulator except for acquiring AUD trace.
If its frequency is set too low, the speed of downloading will be lowered.
If its frequency is set too high, the upper limit for the device’'s TCK clock may be exceeded.

For details of the limitations on both clocks, refer to section 6.5.4, Notes on Using the JTAG
Clock (TCK) and AUD Clock (AUDCK). Thefollowing is adescription of the procedure used to
set the clocks.

29
RENESAS



35 Setting the [Configuration] Dialog Box

» Select [Configure Platform...] from the [ Setup] menu to set acommunication clock. The
[Configuration] dialog box is displayed.

Configuration |

General | Loading fazh memary I

Mode M

Emulation mode INnrmaI j
Step option IDisabIes interrupts during zingle step e:-:eu:utiu:unj
UBC mode I EML j

temary area & Momal  Phypsical © Wirtual 2510 ID'I:I

AUD clock [1/8 CPU clock =

JTAG clack [ 4.125MHz =l

Diriveer: Change... |
] I Cancel | [ | Help |

Figure 3.3 [Configuration] Dialog Box

» Setany valueinthe[AUD clock] and [JTAG clock] combo boxes. The clock also operates
with the default value.

Note: Theitemsthat can be set in thiswindow differ according to the product. For the
settings for each product, refer to the online help.

* Click the [OK] button to set a configuration.
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3.6 Checking the Operation of the Target Memory for Downloading
Check that the destination memory area for downloading is operating correctly.

When the destination memory is SDRAM or DRAM, aregister in the bus controller must be set
before downloading. Set the bus controller correctly in the [I/O Registers] window according to
the memory type. For details, refer to section 8.6, 1/0 Register Display, in the Hitachi Debugging
Interface User’s Manual.

When the required settings, such as the settings for the bus controller, have been completed,
display and edit the contents of the destination memory in the [Memory] window to check that the
memory is operating correctly.

Note: The above way of checking the operation of memory may be inadequate. Itis
recommended that a program for checking the memory be created.

» Select [Memory...] from the [View] menu, enter H' 0c000000 in the [Address] edit box, and
set the format in the [Format] combo box to Byt e.

Cipen Memory Window

Address:

|H05000000

Cancel |
Format:
I Byie LI

Figure3.4 [Open Memory Window] Dialog Box

» Click the [OK] button. The [Memory] window is displayed and shows the specified memory
area.

bddress  Data Yalue ‘l
NCoooo0n 00 o0 00 00 00 00 00 00 00 00 ..., ... _J
NCO0000& 00 o0 00 00 00 00 Q0 00 00 o0 ..........

0C000014 00 00 00 00 00 00 00 00 00 DO ..........
0CO0OD1E 00 00 00 00 00 00 00 00 Q0 DO ..........
0C000028 00 00 00 00 00 00 00 00 00 DO ..........
0CO00032 00 00 00 00 00 00 00 00 00 DO ..........
0CO0003C 00 00 00 00 00 00 00 00 00 DO ..........
0CO00046 00 00 00 00 00 00 00 00 00 DO ..........
0C000050 00 00 00 00 00 00 00 00 00 DO ..........
0CO0005A 00 00 00 00 00 00 00 00 00 DO .......... .

Figure3.5 [Memory] Window
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» Placing the mouse cursor on a point in the display of datain the [Memory] window and double
clicking allows the values at that point to be changed. Data can also be directly edited around
the current position of the text cursor.
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37 Downloading the Tutorial Program

3.7.1 Downloading the Tutorial Program
Download the object program to be debugged.

» Select [Load Program...] from the [File] menu. The [Load Program] dialog box is displayed.
Enter ‘[installation directory]\tutorial\tutorial\Debug\tutorial.abs in the [File name] list box as
shown in figure 3.6, then click the [Open] button.

Load Program

HoO W Verify
Cancel |

File narme:

IO ¥hew¥hdB¥el 0¥t uto rial¥tuto rial¥ De bhug¥t LI Browse. .. |

[T Load only debugging information
¥ Load stack information file(SMI file}

Figure 3.6 [Load Program] Dialog Box

Notes: 1. When installing the emulator, if no directory is specified and the HEW isin use, the
program isinstalled under ‘\Hew\hdi5\e1l0a'. When the HEW isnot in use, the
program isinstalled under ‘\root directory\E10A’.

2. The SNI fileisrequired so that the profiler function can be used.
3. The[Verify] check box is disabled in this product.

After the file has been loaded, the following dialog box displays information about the
memory areas to which the program code has been transferred.

HDI |
taodule name: C:\Hew' \HdAighE 1085 s == Sutanialstutorials\Debugtutonial. abs
Areas lnaded:
OCO00000 - 0CO0023F

Figure 3.7 [HDI] Dialog Box

» Click the [OK] button to continue.
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3.7.2 Displaying the Source Program
The HDI allows the user to debug a program at the source level.

» Select [Source...] from the [View] menu. The [Open] dialog box is displayed.
» Select the C source file that corresponds to the object file the user has loaded.

Open HE

Laak in: I‘a tutarial j gl E

Drebug
Releasze

initsct c
tutorial.c

File name: IM Open I
Files of twpe: II: Files [ .~ inl] j Cancel |

&

Figure 3.8 [Open] Dialog Box

» Select [tutorial.c] and click the [Open] button. The [Source] window is displayed.
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an
3l
3z
a3
a4
3k
36
a7
a8
39
40
41
42
43
44
45
46
47
48
49
50
t1
52
£3
C4
55

<] |

Line | Addre== | BP | Lakel

0=00006c

0c=00006=
0=000076
0=00007=
O=000082

O=0000836

O=0000a2
Oc=0000aa
Oz0000aes
Oz0000b2
0z=0000bA
O=z0000ba
Oz0000z2
Q000 0cze
0=0000za

_maln

1

¥

) tutornial c [_ O] x|

Source -
wold main{void)

long a[l1l0];
long 3:
int 1., min. max:

for{ 1=0; 1<10; i++ 3{
1 = randi);
if{q <« 03f
1 = —1:

al1] = 1.

zort{al:
min
max=
min n
max n:
changeia
min = a[
max = a[
while (1

a[0];
al3];

1:
;I;

)
9
0
i

woid abort (void)

I

AL

Figure3.9 [Source] Window (Displaying the Sour ce Program)

» If necessary, select the [Font] option from the [Customise] submenu on the [Setup] menu to
select afont and size that are legible.

Initially the [Source] window shows the start of the main program, but the user can use the scroll
bar to scroll through the program and look at the other statements.
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3.8 Setting a Softwar e Breakpoint
A breakpoint is a simple debugging function.

The [Source] window provides avery simple way of setting a software breakpoint at any point in
aprogram. For example, to set a breakpoint at the sor t function call:

» Select by double-clicking the [BP] column on the line containing the sor t function call.

Line | Addre== | BF | Label Source ‘I
30 Oc=00006c _main wold main{void)

3l {

32 long a[l1l0];

33 long 3

a4 int 1. min. max:

a5

36 N=00006e for({ i=0; 1<10; 1i++ }{

a7 0z000076 7 = rand():

a8 Qz00007e if(3 ¢« 034

a9 N=0000a2 g S

40 T

41 Q000026 ali] = 7:

42

473 0000022 @ zort(al;

14 Oz0000aa min = a[0]:

45 Oc=0000as max = a[9]:

ip Qz0000b2 min = 0;

17 0z=0000b& max = 0:

L Oc=0000ba changeial

49 Oc0000z2 min = a[9]:

50 O=0000z6 max = a[0]:

51 Oc=0000za while (1);

52 T

53

54 wold abort{void)

55 i r
4 | v

Figure 3.10 [Source] Window (Setting a Softwar e Breakpoint)

The symbol « will appear on the line containing the sor t function, and the word
* Br eak will appear when the [BP] column is extended. This shows that a software
breakpoint has been set.

Note: The software breakpoint cannot be set in the ROM area.
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39 Setting Registers
Set values of the program counter and the stack pointer before executing the program.

¢ Select [Registers] from the [View] menu. The [Registers] window is displayed.

Register |Walue
RO cooooooo
=R cooooooo
RE cooooooo
R3 cooooooo
=g cooooooo
RS cooooooo
R& cooooooo
RY cooooooo
kB cooooooo
=R cooooooo
R10 cooooooo
R11 cooooooo
R1Z cooooooo
R13 cooooooo
R14 cooooooo
R15 cooooooo
BC A0000000
+ 3R -P1B-—-————————————————— ITTT---F
ZBR cooooooo -

Figure3.11 [Registers] Window

RENESAS

37




To change the value of the program counter (PC), double-click the value areain the
[Registers] window with the mouse. The following dialog box is then displayed, and the value

can be changed. Set the program counter to H' 0c00006c¢ in this tutorial program, and click the
[OK] button.

Move the mouse pointer on the value to be changed in the [PC] value area and enter the new
value by the keyboard.

YWalue:
[HOc00006 6 oK I
Set As:

IWhDIe Registar LI Cancel |

38

Figure3.12 [Register] Dialog Box (PC)

Change the value of the stack pointer (SP) in the same way. Set H’0c000c00 for the value of
the stack pointer in thistutorial program.
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3.10

Executing the Program

Execute the program as described in the following:

» To execute the program, select [Go] from the [Run] menu, or click the [Go] button on the

toolbar.

=l

Figure 3.13 [Go] Button

The program will be executed up to the breakpoint that has been inserted, and a statement will
be highlighted in the [Source] window to show the position that the program has halted, with
the message [Break=BREAKPOINT] in the status bar.

Line | Addre== | BF | Label Source -
a0 Ic00006z _main volid main(woid)

al 1

32 long a[l10]:

a3 long 3

3 int i, min. max:
a5

b O=00006e for{ i=0; 1i<10; i++ )4
a7 Oz000076 J = rand():
ag 000007 e ifij « 039
a9 O=000082 1 = -3:
40

i1 O=000086 a[i] = 3:

12

43 Oz000052 zortial;

414 Nz0000aa min = a[0]:

45 Ic0000as max = a[9]:

ig Qz0000b2 min = 0;

17 N=0000kG max = 0

43 Ic0000ka changeia)l

419 000002 min = a[9]:

50 Ic0000zA max = a[0]:

51 Nz0000ca while {1):

52 ¥

53

L4 wvolid abort{woid)

55 { bl
[« | M
Figure 3.14 [Source] Window (Break Status)
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The user can see the cause of the break that occurred last time in the [System Status] window.

» Sdlect [Status] from the [View] menu. After the [System Status] window is displayed, open
the [Platform] page, and check the status of Cause of last break.

S RIMEE|
[tem Status

Connected to: SHweoo ET0A Emulator (E104 PCI Card Driverd)

CPU SH xocxx

Fun status Break

Cause of last break BREAK POINT

Run time count Oh:0min:0s: 16ms

Emulation mode Mormal

Biz endian

AUD Exist

«| | »
Session j, Platform 4 Memory £ Events

Figure3.15 [System Status] Window

Note: Theitemsthat can be displayed in thiswindow differ according to the product. For
theitemsthat can be displayed, refer to the online help.
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3.11 Reviewing Breakpoints
The user can see all the breakpoints set in the program in the [ Breakpoints] window.

» Sedlect [Breakpoints] from the [View] menu.

Breakpoints = Mi=] E3
FilesLine Swvmbol Addre== | Type
tutorial .o 43 QZ0000A2 Breakpoint phy=sical space

Figure3.16 [Breakpoints] Window

The pop-up menu, opened by clicking the [Breakpoints] window with the right mouse button,
also alows the user to set or change breakpoints, define new breakpoints, and delete, enable,
or disable breakpoints.
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3.12 Viewing Memory

When the label name is specified, the user can view the memory contents that the label has been
registered in the [Memory] window. For example, to view the memory contents corresponding to
the _mmai n inword size:

* Select [Memory ...] from the [View] menu, enter _mai n in the [Address] edit box, and set
Wor d in the [Format] combo box.

Open Memoary Window
s o |
= (0]
|_main
Cancel |
Format:
['ord =

Figure 3.17 [Open Memory Window] Dialog Box

» Click the [OK] button. The [Memory] window showing the specified area of memory is
displayed.

# Word Memory - _main

Address Data Valu= AI
QzooooeC  YEFCE E300 1F32 32712 7424 7986
QCoooo?z A012 ooo9 D117 —24558 9 —12009 .J
QCooooze  410E 0009 1F03 16651 9 7939
Qzoooo7?E 4011 8901 s00B 16401 —30463 24587
QCoooosd 1F0:3 S3F2 4308 7939 21490 171e0
QCooooga  e2F3 7210 332C 25331 29200 13100
QCoooo9o S1F3 2312 G3F2 209749 2978 21490
QCoooo9se 7301 1F32 EZ204 29441 7986 7870
Qzoooo9c 51F2 3123 8BE9 20978 12579 —29719
QCooonAz  e4F3 7410 BO19 25843 29712 20455 :j

Figure3.18 [Memory] Window
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3.13 Watching Variables

Asthe user steps through a program, it is possible to watch that the values of variables used in the
user program are changed. For example, set awatch on the long-type array a declared at the
beginning of the program, by using the following procedure:

» Click the left of displayed array a in the [Source] window to position the cursor.

» Click the [Source] window with the right mouse button and select [Instant Watch...] from a
pop-up menu.

The following dialog box will be displayed.

Ihetant Wiatch

e = 1 OxOR000RE T danal i op.
Add Watch |

Figure 3.19 [Instant Watch] Dialog Box
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» Click [Add Watch] button to add a variable to the [Watch] window.

¢ WMatch Window

fWame Yalue
+3 =1 0x0c000bdd 1 (long[10])

Figure 3.20 [Watch] Window (Displaying the Array)
The user can also add a variable to the [Watch] window by specifying its name.

» Click the [Watch] window with the right mouse button and select [Add Watch...] from the
pop-up menu.

The following dialog box will be displayed.

Add Watch |

i sddiess I j ak I
% Y anahle on expression
Canizel |

IITIEIH

Figure3.21 [Add Watch] Dialog Box

* Input variable max and click the [OK] button.
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The [Watch] window will now also show the int-type variable max.

« » Watch Window =] M= E3

Hame Valus
+a ={ 0=z0=000bd8 + {long[l0])
max H'ffffffff { OxlcO00bosd + (dint)

Figure3.22 [Watch] Window (Displaying the Variable)

The user can double-click the + symbol to the left of any variable in the [Watch] window to
watch the all elementsin array a.

« « ‘Watch Window M=] E3

Hame= Valu=

—a ={ 0=0cz000bdg8 ¥} {(long[l0])
[0] H'0ooo03ecz9 { O0x0=000bLdE } {long)
[1] H'0000Z2c8cs { 0x0c000bdc ) long)
[2] H'O00006422 { 0=0z000be0 + (long)
[3] H'ooooofle 4 Ox0c000b=4 + (long)
[4] H'00004e5a { 0x0c=000b=8 ) (long)
[5] H'00005=ed3 { 0=0z000bec + {long)
[B] H'oooozfg2 { 0x0=000LE0 ¥+ long)
[7] H'ooooozo0 4 0z0=000bf4 ) {long)
[8] H'ooooefbf { O0x0=000LfZ } {long)
[9] H'O000047b3 { 0x0c000bfc ) (long)

Max H'ffffffff { 0=0c000bz=8 } {int)

Figure3.23 [Watch] Window (Displaying Array Elements)
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3.14  Stepping Through a Program
The HDI provides arange of step menu commands that allow efficient program debugging.

Table3.2 Step Option

Menu Description

Command

Step In Executes each statement, including statements within functions.

Step Over Executes a function call in a single step.

Step Out Steps out of a function, and stops at the statement following the statement in the

program that called the function.

Step... Steps the specified times repeatedly at a specified rate.

3.14.1 Executing [Step In] Command
The [Step In] steps into the called function and stops at the first statement of the called function.

* Tostepthroughthesort function, select [Step In] from the [Run] menu, or click the [Step
In] button in the toolbar.

1

Figure 3.24 [Step In] Button

46
RENESAS




Line | Addre== | BEP | Label Source -
47 O=0000b& max = 0;

47 O=0000ba changeial

49 Qel0inz2 min = a[9]:

50 O=0000z6 max = a[0]:

51 Oc=0000za while (1);

52 T

53

54 wold abort{void)

55 {

5b

57 N=0000d8 _abort T

58

59 Oz=0000dz _=ort void =sort| long *a)

60 {

Al long t;

62 int 1, j. k. gap:

63

64 Nz0000=0 gap = 5

65 O=0000e=4 while{ gap » 0 }{

13 Oz=0000=8 for{ k=0; kigap: k++3{

67 Nz0oo00f0 for({ i=k4gap: 1i<10:
68 N=0000f= for{j=i-gap: J:
69 Qzooo108 if{aljlzalj-
70 Qz000120 t = alj
71 N=00012=a al3i] =
72 0z00013e al j+gap ™
4] | M

Figure3.25 [Source] Window (Step In)

» Thehighlighted line moves to the first statement of the sor t function in the [Source]
window.
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3.14.2  Executing [Step Out] Command

The [Step Out] steps out of the called function and stops at the next statement of the calling
statement in the main function.

» Tostepout of thesort function, select [Step Out] from the [Run] menu, or click the [Step
Out] button in the toolbar.

Note: It takes time to execute this function.

¥

Figure3.26 [Step Out] Button

?\ Hitachi Pebuqging inferface - tutonial - 5Hxox E10A Emulator

File Edit “iew Bun Memory Setup Window Help
R T T Y EEE T
FEnRs QR NRELFER e we 2 dan
& i tutorial.c M=l B || .. Watch Window ¢ 0] x
Line | Address |EP [Label Source Al Hame | Value
@ 32 long a[l107]; -a ={ 0=0c000bdf } (long[1l01]}
% 33 long j: [@] H'OO0O00O200 { O=0cO00bdAE 3 (long)
=! 34 int i, min. nax; [1] H'OO0000f16 { O=0cO000bde } (long)
o s [2] H'00002c8c { O=x0cO000bel } (long)
36 O0c000094 for({ i=0; i<1l0; i+ [3] H'OOO02f82 { O=x0cO00bed + (long)
S 37 0=000076 j = rand(): [4] H'000036c9 { Ox0c000bed 1 (long)
) 38 0=00007= 1f(3 < 0){ [5] H'000047b3 { 0=x0c000bec } (long)
39 Oco000&2 i= =3 [6] H'O00004=S5a { 0x0c000bE0 } (long)
40 T [7] H'O0005ed3 { Dx0cO00bE4 } {long)
41 O=000086 ali] = 3: [&] H'O0006422 { O=0cO00bid } (long)
i, 42 1 [9] H'O00006fbf { 0Ox0=000bfc } (long)
= 43 0c0000a2 @ b\Sﬂn:nrt(a); max H'ffffffff { O0x0c000bcE + (int)
44 0c=0000aa in = a[0];
n 45 0=0000as max = a[?9]:
16 0=0000b2 min = 0;
=47 0z0000b6 max = 0;
% 48 0=0000ba changei{a):
49 0=0000z2 min = a[9];
== g0 Oc0000cE max = a[0]:
51 Oc0000ca while (1};
52 H
R
b4 void abort{void)
55 iy
EE
57 O=0000d8 _abort }
L]
59 0z0000de _=ort X{Did =ort{long *a) -
KIN 1Y,
4] | B
|Far Help, press F1 [ HUM

Figure 3.27 [HDI] Window (Step Out)

e Thedataof variable a displayed in the [Watch] window is sorted in ascending order.
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e To execute two steps, use [Step In] twice.

Vi Aitachi Detugaing fnterfsce

- tutorial - SHxox E10A Emulator

File Edit “iew Bun Memom Setup ‘window Help

TN Y E T T
|EEams 0@ RE.REE |2 0e 2 @A |

O@d| BREL sy B8 e|

B et o=
Line | Address |EFP [ Label Source Al Hame [ Values
3z long a[10]; —a ={ 0=0=000bd8 } (long[l0]
33 long 3 [0] H'O00000200 { O=x0cO000bdE } {long)
34 int i, min, max: [1] H'O0000f16 { O=x0c000bdce } {long)
35 [2] H'00002c8c { O=x0c000bel } {long)
36 O0z=000094 for{ i=0; i<10; i#d [3] H'O00002f£22 { O=0c000bed } (long)
37 0z=000076 j = randi): [4] H'000036c% { O0=x0c000bed } (long)
38 0=00007e 1fig <« 034 [5] H'000047b3 { O0=x0c000bec } {long)
39 O=000082 j o= -3: [6] H'00004=5a { O0=x0c000bE0 } {long)
40 T [7] H'0000B5=d3 { O=0c000bfd } {long)
41 O=000086 ali] = 3: [8] H'O0000e422 { O=0c=000bf2 } (long)
42 [9] H'O00006fbi { Ox0cO000bfc } (long)
43 O=0000a2 sort{a); max H'00006fbi { O=x0c000boE 3 (int)
44 0=0000&aa min = a[0]:;
45 0=0000ae max = a[9];
46 O0=0000b2 min = 0;
47 O0z0000b6& max = 0:
43 O0c0000ba changeia);
49 0=0000z2 min = a[9]:;
=] 0=0000c6E max = a[0]:
c1 0=0000ca while {1):
52 T
53
E4 woid abort{void)
55
E6
57 O=z0000d8 _abort }
58
E9 O=0000d= _=ort wold sort{long *a) -
<[] ol
1] | B
|Break = STOP ADDRESS [ HUM

Figure3.28 [HDI] Window (Step In —>Step In)

The value of max displayed in the [Watch] window is changed to the maximum data value.
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3.14.3 Executing [Step Over] Command

The [Step Over] executes a function call as a single step and stops at the next statement of the
main program.

» Using [Step Over], execute two steps to reach the change function statement.

?\ Hrtachi Pebugging Inferface - ltonal - SHxox E10A Emulator

File Edit “iew Hun Memory Setup ‘Window Help
PR R|| s pesy | [FRAELBPEaD )T
i HEEHRE. WEE (2508 2 FA b
6 9 tutorial.c M= E || . watch Window <l =0O] =
Line | Address |BP | Label Source «||| Hame [Value
@ 32 long a[10]:; —a ={ 0x=0c000bd8 } (long[l0])}
% 33 long 3 [0] H'OOO0OO200 { O=0=000bdE 3 {long)
& 34 int il min, max: [1] H'00000f16 { 0x0c000bde } (long)
#\ 35 [2] H'00002cE8c { O=0c000be0 } (long)
36 Oc000094 for( i=0; i¢10; i+ [3] H'O0002f82 { O=0c000bed b (long)
S 37 0z000076 i = rand(): [4] H'O000036c9 { Ox0cO00bed } (long)
@ 38 0cz00007e ifi{g ¢ 0){ [5] H'000047b3 { O0=x0c000bec } {long)
39 Ocoo000s2 i= -3 [6] H'00004e5a { 0x0c000bED 3 {long)
@= 40 1 [7] H'00005ed3 { O0=0c000bE£4 }+ (long)
41 Oc000086 ali] = 3: [8] H'O0006422 { Ox0cO00LER } (long)
#, 42 [9] H'O0006fbEf { Ox0cO00bfc } {long)
43 0cO0000a2 @ =ort{a); max H'00000000 { O=0c000bcg 3 (int)
Bl 42 ocoonoaa min = a[0]:
n 45 0c0000ae max = a[9]:
46 Ocz0000b2 min = 0;
=] 47 0=0000b6& max = 0
% 48 0c0000ba changeia);
49 Oc0000c2 min = a[9];
B co 0cz0000c6 max = a[0]:
51 0c0000ca while (1);
£z 1
R | o]
t4 void abort(wvoid)
EE {
56
57 0c000048 _abort 3}
3]
%] Oz00004d= _=ort woid =zort{long *a) -
KiN '
4 { &l
|Break = 5TOP ADDRESS [ [ [NUM

Figure 3.29 [Source] Window (Before Step Over Execution)

¢ To step through all statementsin the change function at asingle step, select [Step Over] from
the [Run] menu, or click the [Step Over] button in the toolbar.

T

Figure3.30 [Step Over] Button
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?\ Hrtachi Pebugging Inferface - latonal - SHx»ox E10A Emulator

File Edit Wiew Hun Memory Setup Window Help |
tomsm| ey |HFaaE et |2
FENAs DR EE., FEE (Moo 28
i | 2
Line | Address |BP | Label Source AI Hame [Walue
@ 32 long a[10]:; —a ={ 0x0c000bd8 } (long[l0])}
T 33 long 3 [0] H'O0006fbf { O=0c=000b4E } (long)
= 34 int i, min, max: [1] H'O0006422 { 0x0c000bdc } flong)
A 35 [2] H'00005ed3 { O0x0c000be0 } §long)
36 0=000094 for( i=0; i¢10; i+ [3] H'00004eba { O0x=0c000bed )} (long)
S 37 0=000076 i = rand(): [4] H'000047b3 { 0x0c000bef } {long)
@ 38 0c00007e ifij < 03{ [5] H'000036cY { Ox0c000bec } (long)
319 0=000082 i= -3 [6] H'O0002£82 { Ox0cO000bEO ) (long)
ar 40 T [7] H'00002c8c { Ox0c000bfd ) {long)
41 0=000086 ali] = 3: [8] H'O0000f16 { O=0c000bE8 )} (long)
#, 42 T [9] H'O0000200 { Ox0cO000bfc ) (long)
& 413 0=000022 @ sartia); max H'00000000 { O=O0cO00bcE 3 (int)
44 Oc0000aa min = a[0]
n 45 Oc0000ae max = a[9]
46 0=0000b2 min = 0;
=] 47 O0=0000b& max = 0
% 48 0c0000ba changeia);
49 000002 min = a[9];
B ) 0c0000c6 max = a[0]:
51 0c0000ca while (1);
52 +
N | ]
t4 void abort(wvoid)
55 {
56
57 O0c0000d48 _abort  }
58
59 Oz00004d= _=ort \{Did =zort{long *a) -
KiN '
] | ©
|Break = STOP ADDRESS [ MM
Figure3.31 [HDI] Window (Step Over)
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3.15 Forced Breaking of Program Executions

The HDI can force a break in the execution of a program.

To execute the remaining sections of the main function, select [Go] from the [Run] menu or
the [Go] button on the toolbar.

=l

Figure 3.32 [Go] Button

The program goes into an endlessloop. To force abreak in execution, select [Halt] from the
[Run] menu or the [Stop] button on the toolbar.

o

52

Figure 3.33 [Stop] Button

The highlighted line of the [Program] window moves to the whi | e statement, and the value
of max displayed in the [Watch] window is updated to the most recent value.
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3.16 Displaying Local Variables

The user can display local variablesin afunction using the [Locals] window. For example, we
will examine the local variablesin the mai n function, which declaresfive local variables: a, j , i ,
m n, and max.

Select [Locals] from the [View] menu. The [Locals] window is displayed.
Initially, the [Locals] window is empty because local variables have not yet been declared.

The [Locals] window will now show the local variables and their values.

- Locals E Ni=] E3

Hamne Valus

+a ={ 0=0z000bdE8 + (long[l0])
3 0'18355 { 0xO0c000bd4 } (long)
i L'10 { O=0=000bA0 }F {int)
min D'517 { O=0c000bocc 3 (int)
max D'28607 { 0=0c000bc8 F (int)

Figure 3.34 [Locals] Window

Double-click the + symbol in front of array a in the [Locals] window to display the elements
of array a.

Refer to the elements of array a before and after the execution of thesor t function, and
confirm that random datais sorted in descending order.

RENESAS

53




3.17 Break Function

The emulator has software and hardware break functions. With the HDI, a software breakpoint
can be set using the [Breakpoints] window, and a hardware break condition can be set using the
[Break Condition] dialog box.

An overview and setting of the break function are described below.

3.17.1  Software Break Function

The emulator can set up to 255 software breakpoints. Other methods for setting a software
breakpoint than in section 3.8 are described below.

» Select [Breakpoints] from the [View] menu. The [Breakpoints] window is displayed.

¢ Click the [Breakpoints] window with the right mouse button and select [Delete All] from the
pop-up menu to cancel all the breakpoints that have been set.

Breakpoints

Enable |File/Line Symbol |Address |Type

Figure 3.35 [Breakpoints] Window (Before Softwar e Breakpoint Setting)
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Click the [ Breakpoints] window with the right mouse button and select [Add] from the pop-up

menu.

The [Break] dialog box isdisplayed. The [Point] page is displayed as a defaullt.

Break

Faint | Condition I

Break paint

]|

T O e

e

o |

Cancel | Sl

Help

Figure3.36 [Point] Page ([Break] Dialog Box)

RENESAS

55




e Click the[Add...] button to display the [Breakpoint] dialog box.
e Enter H 0c0000c2 tothe [Vaue] edit box.

Breakpoint

H'0z0000:2

Figure 3.37 [Break Point] Dialog Box

¢ Click the [OK] button.
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The [Break] dialog box isdisplayed. The address set in the value field of [Breakpoint] and the
memory space are displayed.

Break |
Faint | Condition I

Breakpoint
H'ICON00C: E’husical ZDACE

agd. |  Edi. | Beset | Resetal |

Cloze I [Eareel | ][] | Help |

Figure 3.38 [Point] Page ([Break] Dialog Box) (After Software Breakpoint Setting)

» Click the [Close] button (or [OK] button in some emulator products).
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The software breakpoint that has been set is displayed in the [Breakpoints] window.

Breakpoints =1 =]
FilesLine Symbol Addre=s Type
tutorial . c49 Qzooo0c?  Breskpoint physical space

Figure3.39 [Breakpoints] Window (Software Breakpoint Setting)
To stop the tutorial program at the breakpoint, the following procedure must be executed:

» Close the [Breakpoints] window.

»  Set the program counter and stack pointer values (PC = H’ 0c00006c and R15 = H’ 0c000c00)
that have been set in section 3.9, Setting Registers, in the [Registers] window. Click the [Go]
button.

The program runs, and stops at the set breakpoint.

Line | Addre== | BF | Label Source ‘I
40 T

i1 N=000086 a[i] = 3:

42

43 O=0000a2 zort(al;

14 Oz0000aa min = a[0]:

45 Oc=0000as max = a[9]:

ip Qz0000b2 min = 0;

17 0z=0000b& max = 0:

47 O=0000ba changeial

49 Nc0000c2 & min = a[9]:

50 O=0000z6 max = a[0]:

g1 0=0000za while (1);

52 T

53

54 wolid abort{void)

55 {

56

57 N=0000d8 _abort T -
KX M

Figure3.40 [Source] Window at Execution Stop (Softwar e Break)

58
RENESAS




The [System Status] window displays the following contents.

ol _ToIx]|
Status
Connected to: SHxwee ETOA Emulator (E104 PCI Card Driverd)
CPU SH soocx
Fun status Break
Cause of last break BREAK POINT
Fun time count Oh:Omin:Os: 16ms
Emulat ion mode Mormal
Big endian
ALD Exist
«| | 3
Session j Platform 4 Wemary 4 Events

Figure3.41 Displayed Contents of the [System Status] Window (Softwar e Break)

Note: Theitemsthat can be displayed in thiswindow differ according to the product. For
theitemsthat can be displayed, refer to the online help.
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3.18 Hardware Break Function

A method is given below in which the address bus condition and the read cycles for the bus status
condition are set under Break Condition 1 as hardware break conditions.

» Select [Breakpoint Window] from the [View] menu. The [Breakpoints] window is displayed.
¢ Click the [Breakpoints] window with the right mouse button and select [Delete All] from the
pop-up menu to cancel all breakpoints that have been set.

» Click the [Breakpoints] window with the right mouse button and select [Add] from the pop-up
menul.

Breakpaints

Enakle |[File/Line gymbol |[Address |Type

Edit..
Eqatled

[e(ete

e(=te Al

Gio) o Source

Figure3.42 [Breakpoints] Window (Before Hardware Break Condition Setting)
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The [Break] dialog box is displayed. To set hardware break conditions, select [Condition] in the
[Break] dialog box to display the [Condition] page.

Break |
Point  Condition |

Break Condition

ET e

k. I Cancel | ] | Help |

Figure 3.43 [Condition] Page ([Break] Dialog Box)

Up to three breakpoints can be set independently for the Break Condition hardware break
condition. In this example, set the hardware break condition for Break Condition 1.

Note: The number of hardware break conditions differs according to the product. For the
number that can be specified for each product, refer to the online help.

» Highlight the first point in the [Break Condition] list box.
» Click the [Edit...] button. The [Break Condition 1] dialog box is displayed.
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* Clear the [Don't Care] check box in the [Address] page.

» Select the [Address] radio button and enter H 0c0000b2 asthe value in the [Address] edit
box.

Break condition 1 |

Address |Data I A510 I Bus statel

—Addreszz
[T Don't care

i Addiess
£ Only program fetched address

" Only program fetched address after

Address |H'IIIu:IZIIZIIIIIIII:-2

Maszk IN:::n Lzer maszk, j

] 4 I Cancel | SEply | Help |

Figure3.44 [Address] Page ([Break Condition 1] Dialog Box)

Note: Theitemsthat can be set in thiswindow differ according to the product. For the
settings for each product, refer to the online help.
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» Select [Bus State] to display the [Bus State] page.
» Select the [Read] radio button in the [Read/Write] group box.

Break condition 1 |

Addiess | Data | ASID Bus state |

Busz state

Read wiite
" Read/write
% Bead
 Wwiite

] 4 I Cancel | SEply | Help |

Figure 3.45 [Bus State] Page ([Break Condition 1] Dialog Box)

Note: Theitemsthat can be set in thiswindow differ according to the product. For the
settings for each product, refer to the online help.
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» Click the [OK] button.
» The[Break] dialog box is displayed, and the first point display in the [Break Condition] list
box changes from Enpt y to Enabl e.

Break |
FPaoint  Condition |

Break Condition

2 Empty
3 Empty

Edt. |  Beset | Resetay |

(] 4 I Cancel | Sl | Help |

Figure3.46 [Break] Dialog Box (After Hardware Break Condition Setting)

Note: The number of hardware break conditions differs according to the product. For the
number that can be specified for each product, refer to the online help.

* Click the [OK] button.
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The newly set hardware breakpoint is displayed in the [Breakpoints] window. With this setting,
Break Condition 1isdisplayedin[Type] inthe [Breakpoints] window.

This completes the setting of the Break Condition 1 hardware break condition. When the program
is executed, a break will occur when address H'0c0000b2 is accessed in aread cycle.

Breakpoints =1 I ]

Tvpe
OCO000EZ2 EBreak condition 1

Figure 3.47 [Breakpoints] Window ([Break Condition 1] Setting)

» Close the [Breakpoints] window.

»  Set the program counter and stack pointer values (PC = H’ 0c00006c and R15 = H’ 0c000c00)

that have been set in section 3.9, Setting Registers, in the [Registers] window. Click the [Go]
button.
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The program runs then stops at the condition specified under Break Condition 1.

Line | Addre== | BFP |[Lakel Source ‘I
3l i

3z long a[1l0];

a3 long 3:

a4 int 1., min. max:

a5

b Nz00006e for{ 1=0; 1<10; i++ 3{

a7 0=000076 i = rand();

a8 Qz00007e if(3 ¢ 034

a9 Qzooonaz i = -3:

40 T

i1 Q000086 ali]l = 3:

42

473 O=0000a2 =ort(al:

44 Oc=0000aa min = a[0]:

4§ Oz0000as max = a[9]:

i6 Nz0000b2 min = 0O;

47 Qz0000be max = 0;

47 0=0000ba changeial: -
KX M

Figure 3.48 [Source] Window at Execution Stop (Break Condition 1)
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The [System Status] window displays the following contents.

ol _ToIx]|
Status
Connected to: SHxwee ETOA Emulator (E104 PCI Card Driverd)
CPU SH soocx
Fun status Break
Cause of last break BREAK COMDITION 1
Fun time count Oh:Omin:Os: 16ms
Emulat ion mode Mormal
Big endian
ALD Exist
«| | 3
Session j Platform 4 Wemary 4 Events

Figure3.49 Displayed Contents of the [System Status] Window (Break Condition 1)

Note: Theitemsthat can bedisplayed in thiswindow differ according to the product. For
theitemsthat can be displayed, refer to the online help.
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3.18.1  Setting the Sequential Break Condition

The emulator has sequential break functions. When the hardware break conditionslisted in table
3.3 are satisfied, program execution is halted. This modeis called sequential break.

Table3.3 Sequential Break Conditions

Break Condition Description

Sequential break condition 2-1 Program is halted when Break Condition 2 and Break
Condition 1 are satisfied in that order.

Sequential break condition 2-1 is described below as an example.

Before executing the program, change setting in the [Configuration] dialog box. Otherwise, the
sequential break does not function.

» Select [Configure Platform...] from the [Setup] menu. The [Configuration] dialog box is
displayed.
» Select Sequentia break condition 2-1 from the [Emulation mode] combo box.
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Configuration

General | Loading flazh memu:uryl

tode

Emulation mode

Step optioh

LBC mode

temary area

AUD clock

JTAG clock,

ISHxxxx j

Seguential break condition 2-1

IDisaI:uIes interrupts during single step e:-:eu:utiu:unj

IBreak condition 6,7 j

& Maomal O Physical © Vitual 2500 ID'I:I

[1/8 CPU clock =l

[ 4.125MHz =l

Dirver:

Change... |

k. I Cancel | e 1 | Help |

Figure 3.50 [Configuration] Dialog Box (Sequential Break Setting)

Note: Theitemsthat can be set in thiswindow differ according to the product. For the
settings for each product, refer to the online help.

Click the [OK] button and close the [Configuration] dialog box.
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Set hardware break conditions as follows:

Break condition 1. When address H'0c0000c6 is accessed in aread cycle, abreak conditionis
satisfied.

Break condition 2: When address H'0c0000b2 is accessed in aread cycle, abreak condition is
satisfied.

Follow the setting method described in the previous section.

» When Break Condition 1,2 setting has been completed, the state of the [ Breakpoints] window

isasfollows.
Breakpoints =1 I ]
File<Line

VD
] tutorial .50 0Co000CE Break condition 1
0] tutorial .46 OCO000BZ Bresk condition 2

Figure3.51 [Breakpoints] Window (After Sequential Break Condition Setting)

» Close the [Breakpoints] window.

» Set the program counter and stack pointer values (PC = H’ 0c00006¢ and R15 = H’ 0c000c00)
that have been set in section 3.9, Setting Registers, in the [Registers] window. Click the [GO]
button.

70
RENESAS




The program runs then stops at the condition specified under Break Condition 1.

tutorial.c
Line | Addre== |EF | Lakel Source -
40
41 Q000086 afi] = 7;
42
43 Oc=0000a2 =ortial;
44 Nc0000&aa min = a[0]:
45 Ic0000as max = a[9]:
456 Oz0000b2 min = 0;
47 0z0000bBR max = 0;
43 Oc0000ba change(a);
419 Q00002 min = a[9];
50 O=0000zR maz = a[0]:
51 Oc=0000cza while (1);
52 T
53
54 vwoid aborti{wvoid)
55§ {
1]

57 O=0000d8 T -
KX M
Figure3.52 [Source] Window at Execution Stop (Sequential Break)
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The [System Status] window displays the following contents.

Srsten 5 ol _ToIx]|

[tem Status

Connected to: SHxwee ETOA Emulator (E104 PCI Card Driverd)

CPU SH soocx

Fun status Break

Cause of last break BREAK COWNDITION 31

Fun time count Oh:0min:Os: 16ms

Emulat ion mode Sequential break condition 2-1

Big endian

ALD Exist

«| | 3
Session j Platform 4 Wemary 4 Events

Figure 3.53 Displayed Contents of the [System Status] Window (Sequential Break)

Note: Theitemsthat can bedisplayed in thiswindow differ according to the product. For
theitemsthat can be displayed, refer to the online help.
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3.19 TraceFunctions
The E10A emulator has two branch-instruction trace functions.

(1) Internal Trace Function

The branch source and branch destination addresses, mnemonics, operands, and source lines are
displayed. Since this function uses the trace buffer built into the MCU, arealtime trace can be
acquired.

Notes: 1. The number of branch instructions that can be acquired by atrace differs according to
the product. For the number that can be specified for each product, refer to the online
help.

2. Theinterna trace function is not supported for all products. For the specifications of
each product, refer to the section related to the trace functions in section 6, SHxxxx
E10A Emulator Specifications, or to the online help.

3. Theinterna trace function is not extended for all products. For the specifications of
each product, refer to the section related to the trace functions in section 6, SHxxxx
E10A Emulator Specifications, or to the online help.

(2) AUD Trace Function

Thisisthe large-capacity trace function that is enabled when the AUD pin is connected to the
emulator. Thisfunction displays the branch source and branch destination addresses, mnemonics,
operands, and source lines.

When the branch source and branch destination instructions are one branch, the number of branch
instructions acquired by atrace is a maximum of 4,096 in the PCM CI A-type emulator and a
maximum of 16,384 in the PCl-type emulator.

Table 3.4 shows the AUD trace function.

Notes: 1. The AUD trace function is not supported for all products. For the specifications of
each product, refer to the section related to the trace functions in section 6, SHxxxx
E10A Emulator Specifications, or to the online help.
2. The AUD trace function is not extended for all products. For the specifications of each
product or the number of acquired branches, refer to the section related to the trace
functionsin section 6, SHxxxx E10A Emulator Specifications, or to the online help.
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Table3.4 AUD Trace Functions

Type Mode Description

Acquisition Realtime trace When the next branch occurs while the trace information is
mode when being output, the output is stopped and the next trace
branches information is output. The user program can be executed in

continuously
occur

realtime, but some trace information will not be output.

Non realtime trace

When the next branch occurs while the trace information is
being output, the CPU stops operations until the information
is output. The user program is not executed in realtime.

Acquisition Trace continue This function always overwrites the oldest trace information

mode when to acquire the latest trace information.

Lhiftracfth Trace stop The trace information is not acquired. The user program is
utier ot the continuously executed.

emulator

becomes full
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3.19.1 Internal Trace Function

The branch source and branch destination information for the latest several branch instructions are
displayed.

The following is a procedure to set the internal trace function (this function is not needed to be set
in the emulator that does not support the AUD trace function):

1. Select [Trace] from the [View] menu.

2. Click the [Trace] window with the right mouse button and select [Acquisition] from the
pop-up menu to display the [Trace Acquisition] window.

3. Select the[Interna trace] radio button in the [Trace type] group box.

Trace Acquisition

Trace mode

Trace type:  AD trace

ALUD model: %] Bealtime trace ) [dom realtime trace

ALUD modeZ: %) Trace continue ) Trace stop

A LD trace display range:

Start pointer I [rE191

End pointer I o

| I I Cance| | I e ) Help

Figure3.54 [Trace mode] Window

Note: Theitemsthat can be set in thiswindow differ according to the product. For the
settings for each product, refer to the online help.
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Run the program as shown in the example of section 3.17.1, Software Break Function. The trace
results are displayed in the [ Trace] window after the program execution is completed.

[ Trace - 16 records [no filter] = M=] 3

T DATA|MNEMO] OF ERAND Source
1 -0 000007 BRANCI OCO001F4 w+¥+ EF @H'C000100: 8

= 14 DESTTI 0CO001D0 *¥¥+ MOv.L @R15,R1 ali] = tmp[9 -

-000013 -D' 000006 BRANCIOCOO01F4 #¥+% EF  @H'CO001D0:8

-000012 DESTII Q000100 = Moy, L @R15,R1 ali] = tmp[9 -

-000011 -D' 000005 BRANC OCO001F4 *+++ BF @H'C0001D0: 8

-000010 DESTTI OCO001D0 ¥¥* MOV.L @R15,R1 ali] = tmp[9 -

-00000% -D' 000004 BRANC OCOQ0LF4 *w+¥ RF @H'C000100: 8

-000008 DESTII OCO001D0 **++ MOy, L @R15,R1 ali] = tmp[® - -

-000007 -D' 000003 BRANCIOCO001F4 #%+% EF  @H'CO001D0:8

-000006 DESTII Q000100 = Moy, L @R15,R1 ali] = tmp[9 -

-000005 -D' 000002 BRANC OCO001F4 *+++ EF @H'C0001D0: 8

-000004 DESTTI OCO001D0 ¥¥* MOV.L @R15,R1 ali] = tmp[9 -

-000003 -D' 000001 BRANC OCOQ0LF4 *w++¥ RF @H'C000100: 8

-000002 DESTII OCO001D0 **++ MOy, L @R15,R1 ali] = tmp[® - -

-000001 -D' 000000 ERANCI OCOOQ1FE ¥¥%% RTS

+000000 DESTII OCO000C2 =+ MOV, L @{H' 34:4,R15),R2 min = al9];

KN I

Figure3.55 [Trace] Window

» If necessary, adjust the column width by dragging the header bar immediately below thetitle
bar.

Note: Thenumber of branch instructionsthat can be acquired by atrace differsaccording
totheproduct. For the number that can be specified for each product, refer tothe
online help.
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3.19.2 AUD Trace Function
Thisfunction is operational when the AUD pin of the MCU is connected to the emulator.

The following is the procedure for setting the AUD trace function (this function does not need to
be set in an emulator that does not support the internal trace function):

1. Select [Trace] from the [View] menu.

2. Click the [Trace] window with the right mouse button and select [Acquisition] from the
pop-up menu to display the [Trace Acquisition] window.

3. Select the[AUD trace] radio button in the [Trace type] group box.

Trace Acquisition

Trace mode

" Internal trace

Trace type: O ﬁ ..............

ALUD model: {* Bealtime trace " Mon realtime trace

ALUD modeZ: {* Trace continue " Trace stop

A LD trace display range:

Start pointer I DrE191

End pointer I oo

| Ok I Cancel | Lipcakeih) Help

Figure3.56 [Trace mode] Window
Note: For adescription of each option, refer to table 3.4.

Note: Theitemsthat can be set in thiswindow differ according to the product. For the
settings for each product, refer to the online help.

The trace results are displayed in the [ Trace] window after the program execution is completed.
The display specificationsin the [Trace] window are the same as the internal trace function.
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The following is an example of the display in the SH7751 E10A emulator.

IF TYPE ADDR DATA MNEMONIC | OPERAND Source a
-D' 000034 MEMORY 0CO00BCY OCO00BDS
-D' 000033 MEMORY QCO00BSE 00000006
-000036  -D' 000032 MEMORY DCO00EAB O0003BES
-00003%  -D' 000031 MEMORY OCO00EFO O0003BES
-000034  -D' 000030 MEMORY DCO00E98 00000006
-000033  -D' Q00029 MEMORY QCO00B98 00000007
-000032  -D' 000028 MEMORY QCO00BSE 00000007
-000031  -D' Q00027 BRANCH QCOo00z10 N R @H'COD01EC: B
-000030 DESTINATION  OQCO001EC wEREEEEE MOY, L @R15%,R1 alil = tmp[@
-000029  -D' 000026 MEMORY DCO00ESE Q0000007
-000028  -D' Q00025 MEMORY QCO00BCY QCO00BDE
-000027  -D' 000024 MEMORY DCO00E98 Q0000007
-000026  -D' Q00023 MEMORY QCO00BAY oooozald
-000025  -D' 000022 MEMORY QCO00BFY 00002A14
-000024  -D' 000021 MEMORY 0CO00E98 00000007
-000023  -D' 000020 MEMORY QCO00B98 00000008
-000022  -D' 000019 MEMORY DCO00ESSE 00000008
-000021  -D' Q00018 BRANCH QCOo00210 R @H'CO001EC: B
-000020 DESTINATION OCOO001EC TR O L @R15,R1 a[i]l = tmp[9
-000019  -D' Q00017 MEMORY QCO00BSS 00000008
-000018  -D' 000016 MEMORY QCO00BCH OCO00BDE
-000017  -D' 000015 MEMORY DCO00ES8 00000008
-000016  -D' 000014 MEMORY OCO00BEAQ Q00D06CC
-00001%  -D' 000013 MEMORY DCO00BFS 000006CC
-000014  -D' Q00012 MEMORY QCO00B98 00000008
-000012  -D' 000011 MEMORY OCO00BSE 00000009
-000012  -D' Q00010 MEMORY QCO00BSS 00000009
-000011  -D' 000009 BRAMNCH QC000210 R E @H'COO01EC: B
-000010 DESTINATION OCO001EC TR OV | @R15,R1 a[i] = tmp[9
-000009  -D' Q00008 MEMORY QCO00BSE 0000000S
-000008  -D' 000007 MEMORY 0C000BCS OC000BDE
-000007  -D' Q00006 MEMORY QCO00BS9S 00000009
-000006  -D' 000005 MEMORY QCO00ESC 00000063
-000005  -D' 000004 MEMORY OCO00BFC 00000063
-000004  -D' 000003 MEMORY QCO00B98 00000009
-0000032  -D' 000002 MEMORY DCO00ESE 0000000A
-000002  -D' Q00001 MEMORY QCO00B98 0000000A
-000001  -D' 000000 ERAMCH 0C000214 wEREE RTS
+000000 DESTINATION  QCO0000A wEEEEEEE MO, L @(H'34:4,R15),R2 min = a[9];
=
[« | v
Figure 3.57 [Trace] Window in the SH7751 E10A Emulator
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3.19.3 VP_MAP Trandation

The MCU, which hasan MMU, trandates internal addresses (virtual addresses) to actual memory
addresses (physical addresses). Address trandation is performed according to the address
trandlation table (trandlation look-aside buffer: TLB) inthe MCU. The MMU operates during
command input wait state as well as during user program execution. When a command for
memory access is executed while the MM U address translation function is enabled, the address
trandated by the MMU is accessed. If the specified addressis not within the TLB, a TLB miss
occurs, and the TLB must be updated by the user program.

The emulator has address translation functions according to the VP_MAP tables. The VP_MAP
tables are the address trandlation tables for the emulator created with the VPMAP_SET command.

The following shows an example of how to use the VP_MAP tables.
Example:

1. Create VP_MAP tablesfor trandating virtual addresses H'10000 to H'10FFF to physical
addresses H'4000000 to H'4000FFF and virtual addresses H'11000 to H'11FFF to physical
addresses H'0 to H'FFF.
>vs 10000 10FFF 4000000 (RET)
>vs 11000 11FFF 0 (RET)

>vd (RET)

<VADDR TOP> <VADDR END> <PADDR TOP>
00010000 00010FFF 04000000
00011000 00011FFF 00000000

DI SABLE

2. Then, enable the VP_MAP tables. (When the tables are disabled, addresses are not trandated.)
>ve ; enabl e (RET)

>vd (RET)

<VADDR TOP> <VADDR END> <PADDR TOP>
00010000 00010FFF 04000000
00011000 00011FFF 00000000
ENABLE

Here, virtual addresses correspond to physical addresses as shown in figure 3.58.
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Figure3.58 Address Trandation accordingto VP_MAP Tables

How to trandate addresses depends on the settings of the radio buttons of the memory area group
in the [Configuration] dialog box. The following shows how to trandate addresses in each setting
State.

*  When the Normal radio button is selected:
The VP_MAP table has a priority over the TLB. When the VP_MAP table is enabled and the
specified address is within the VP_MAP table settings, the emulator translates the address
according to the VP_MAP table. If the specified addressis outside the VP_MAP table settings
even when the VP_MAP table is enabled, or when the VP_MAP table is disabled, the emulator
tranglates the address according to the MMU state.

*  When the Virtual radio button is selected:
The addressistrandated according to the TLB. If the specified addressis outside the TLB
table settings, a TLB error will occur.

¢ When the Physical radio button is selected:
The addressis not translated.
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Table3.5 AddressTrandation Tables

VP_MAP MMU
Within/
Radio Enabled/ Outside Enabled/ Within/Outside Table Used for
Button* Disabled therange Disabled the TLB Range Translation
Normal Enabled Within the Enabled Within the Range Translated according to
Range the VP_MAP table
Outside the range Translated according to
the VP_MAP table
Disabled  Within/outside the Translated according to
range the VP_MAP table
Outside the  Enabled Within the Range Translated according to
Range the TLB table
Outside the range TLB error
Disabled  Within/outside the Not translated
range
Disabled  Within/ Enabled Within the Range Translated according to
outside the the TLB table
range
Outside the range TLB error
Disabled  Within/outside the Not translated
range
Virtual Enabled/  Within/ Enabled Within the Range Translated according to
disabled outside the the TLB table
range
Outside the range TLB error
Disabled  Within the Range Translated according to
the TLB table
Outside the range TLB error
Physical Enabled/  Within/ Enabled/  Within/outside the Not translated
disabled outside the  disabled range
range
Note: Specified by the [Memory area] group box in the [Configuration] dialog box.
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3.20 Stack Trace Function

The emulator uses the stack’ s information to display the name of the calling function for a
function at which the program counter is currently pointing.

Notes: 1. Thisfunction can be used only when the load module that has the Dwarf2-type
debugging information is loaded.

2. For details on the stack trace function, refer to the online help.

» Double-click the [BP] columninthesort function and set a software breakpoint.

tutonal.c
Line | Addre== |EP | Lakel Source
La
59 0c=0000dz _=ort void =ort(long *a)
&0 {
61 long t:
(9 int 1. j. k. gap:
(%]
64 Oz0000e0 gap = &
65 Iz0000=4 while{ gap > 0 14
1] 0=0000=8 for({ k=0; ki<gap: k++){
67 Oz0000£0 for({ isk+4gap: i1<10; i=1
X5 Oz0000fc for{j=i—gap; j:=k;
%] O=000108 if{aljlralj+gar
70 0cO00120 @ t = alil:
71 0z00012a alj] = a[j+
72 0c=00013e alj+gap] =
73 T
74 el=e
75 0000150 brealk A
K M

Figure 3.59 [Source] Window (Softwar e Breakpoint Setting)

» Set the same program counter and stack pointer values (PC = H’ 0c00006¢ and R15 =
H’0c000c00) as were set in section 3.9, Setting Registers (again, use the [Registers] window).
Click the [Go] button.

» After the break in execution, select [Stack Trace] from the [View] menu to open the [ Stack
Trace] window.
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il Stack Trace M= E

Kind Name Walue

F sortClong™®) T 0x0co0olzo b
F maini) I 0x0co000aa +
F maing ) I 0x0c0000aa +
F maini ) I Dx0cO000aa b
F maini) I 0x0cO000aa b
F maini) I 0x0co000aa +
F maing ) I 0x0c0000aa +
F maini) I 0x0co000aa b
F maini) I 0x0cO000aa b
F maini) I 0x0co000aa +

Figure 3.60 [Stack Trace] Window

Figure 3.60 shows that the position of the program counter is currently at the selected line of the
sort () function, and that thesort () functioniscalled fromthemai n() function.

Notes: 1. If the function isnot deeply nested (lower than 10), the mai n() function will be
displayed multiple times.
2. For details on this function, refer to the online help. The online help is opened when
the [F1] key is pressed in the [Stack Trace] window.
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3.21  Profiling Function
The profile function can measure performance for each function.

Notes: 1. Readltime operation is not possible while thisfunction isin operation, since internal
breaks are generated during program execution. Measuring the profile itself affects the
measurements. For details, refer to section 6, SHxxxx Emulator Specifications.

2. When thisfunction isto be used, click the [Load stack information file (SNI file)]
check box in the [Load Program] dialog box to load the stack information file.

3. Performance profile measurement is not supported for all products. On those
products for which it is supported, its characteristics differ according to the product.
For specifications for each product, refer to the section related to the trace functionsin
section 6, SHxxxx E10A Emulator Specifications, or to the online help file.

4. For details, refer to section 13 in the Hitachi Debugging Interface User’s Manual.

» Select [Profile-List] from the [View] menu to open the [Profile-List] window. A different set
of datato be measured can be set for each function.

3 Profile-List

__INITSCT

Address S1ze
H'0CO000000 H' 0000006C
H'OCOO01FC  H'0000002C
H'OC000194  H' 00000062
H'OCO000DC  H' 000000BE
H' 0CO0000Ds H' 00000004
H'OCO0006C H' 0000006C

Figure 3.61 [Profile-List] Window
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The profile function is now enabled. Place the mouse cursor on an entry in the [Profile-List]
window, click the right-hand mouse button, then select [Enable Profiler] from the pop-up

menu.

Profile
Function/WVariable Address gize Times Data 1
_ THNTTICT H'OCOoOoQoo PEY NateAa Tl =t el N -
_rand H'O0cO0OL1Fe Wiew Source
—change H'0cO0001%4 Wiewn Profile-Tree
_sort H'0cOo000DC ) :
_abort H'O0CO000DE Wiews Profile-Chart
main H'OCO0000&:
- ’T Enable Profiler
Find.. =]
Clear Data

4
—I—I Ciutput Profile Information File..

Ciutput Text File..

Select Data..

Setting..

Figure 3.62 Selection of [Enable Profiler]
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Datato be measured for the selected function is now set. Select [Select Data] from the pop-up
menu by clicking with the right mouse button. The [Select Data] dialog box is displayed.

Select Data

Data 1 IAII operand access count LI

Data 2 IEIapsed—time cycle LI

86

Figure 3.63 [Select Data] Dialog Box

Use the [Select Data] dialog box to select the data to be measured. [All operand access count]
is selected for Datal as afirst item to be measured. [Elapsed-time cycle] is selected for Data2
as a second item to be measured.

After the data has been selected, press the [OK] button.

Double-click the [BPF] column for the whi | e statement of the mai n function to set a software
breakpoint.
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Line | Addre== | BP | Label Source -
34 int 1. min. max:

35

26 Oc00006e for{ i=0; 1<10; i++ 3
a7 0=000076 7 = randi):

3 Oc00007e ifi{j <« 039

a9 O=000082 1= —3:

40 ¥

11 Oz000086 ali] = 3:

12

43 Qc=0000a2 zortial:;

44 Nz0000aa min = af[0]:

45 O=0000as max = a[9]:

46 Oz0000b2 min = 0O;

47 0=0000bA max = 0;

43 0c=0000ka changeia)l

49 Oc=0000z2 min = a[9]:

&0 Nc=0000cE max = a[0]:

51 Qc0000Ca @ while (1);

52 I -
C2

4| I » ;}:

Figure3.64 [Source] Window (Software Break Setting)

»  Set the same program counter and stack pointer values (PC = H’ 0c00006¢ and R15 =
H’ 0c000c00) as were set in section 3.9, Setting Registers (again, use the [Registers] window).
Click the [Go] button.

» After the break in execution, the results of the measurements are displayed in the [Profile-List]
window.

3 Profile-List

Function/Variable Address Size Times Data 1 Data 2
_ INITECT HTOCO00O000 HTO00O000&C u] ] u]
_rand HT'OZ0001FS HTOOOOODZ 10 an 621a

change HTOC000194 HT'O0OOOOOGZ 1 165 15066

BT i oco000Dc HTOOOOOOBE 1 787 70016
_abort HTOZ0000DE HTOOOOoOOO4 a u] u}

_main HTOCOO0OD&T HTO00O0OOD&C 1 2a 10532

Figure 3.65 [Profile-List] Window
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» Figures 3.66 and 3.67 show the [Profile-Tree] and [Profile-Chart] windows, respectively.

* 3 Profile-Tree ol o x]|
Function Address Fize gtack Size |Times Data 1 |Data Z2
—Application
__ INITSCT H'0c000000 H'0000006c  H'00000008 O 0 0
abort H'0c0000DE  H'00000004  H'O00O0OOOOO O 0 0
EEEYEEE o coo00cc HTO000006C  HTOOOOOO38 1 88 10532
_rand H'0CO001FC  HT000000ZC  H'00000000 10 80 6216
_change H'0c00015a H'00000062Z H"00000030 1 165 15066
_sort H'0c0000D¢ HTOODOOOBE  H'O00000O18 1 787 70016
] | i

Figure 3.66 [Profile-Tree] Window

hart - _main -

main

‘ 4 of

Figure 3.67 [Profile-Chart] Window
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3.22 Download Function to the Flash Memory Area

The E10A emulator enables downloading to the flash memory area. Thisfunction requires a
program for writing the flash memory (hereinafter referred to as awrite module), a program
for erasing the flash memory (hereinafter referred to as an erase module), and the RAM area
for downloading and executing these modules.

Note: The write/erase module must be prepared by users.

O Interface with write/erase module and E10A emulator firmware

The write/erase module is branched from the E10A emulator firmware. To branch from
the E10A emulator firmware to the write/erase module or to return from the write/erase
module to the E10A emulator firmware, the following conditions must be observed:

» Describe all the write/erase modules with the assembly language.

» Guarantee al the general/control register values before and after calling the write/erase
module.

* Return the write/erase module to the calling source after processing.

The module interface must be as follows to pass correctly the information that is required
for flash memory accessing.

Table3.6 Modulelnterface

Module Name Argument Return Value

Write module R4(L): Write address RO(L): End code
R7(L): Verify option Normal end = 0_
0 = no verify, Abnprmal erld = other than 0,
1 = verify Verify error = BT

R5(L): Access size
0x4220 = byte,
0x5720 = word,
0x4C20 = longword

R6(L): Write data

Erase module R4(L): Access size None
0x4220 = byte,
0x5720 = word,
0x4C20 = longword

Note: The (L) means the longword size.

Note: Write module:
Thewrite datafor the accesssizeis set to the R6 register. When the accesssizeis
word or byte, Oisset tothe upper bit of the R6 register.
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O Flash memory download method

Itisrequired to perform necessary settings on the [Loading flash memory] pagein the
[Configuration] window for downloading to the flash memory.

Configuration

I |

32-bit buz width

o
jfo

Figure 3.68 [Loading flash memory] Page
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Table 3.7 shows the options for the [Loading flash memory] page.

Table 3.7 [Loading flash memory] Page Options

Option

Description

[Loading flash memory]
radio button

Sets Enable for flash memory downloading.

At Enable, when [File load] is selected from the [File] menu for
downloading, the write module is always called.

Enable: Download to the flash memory

Disable: Not download to the flash memory

[Erasing flash memory]
radio button

Sets Enable for erasing before the flash memory is written.

At Enable, the erase module is called before calling the write module.
Enable: Erase the flash memory
Disable: Not erase the flash memory

[File name] edit box

Sets the write/erase module name. The file that has been set is
loaded to the RAM area before loading to the flash memory.
A maximum of 128 characters can be input for the file name.

[Bus width of flash
memory] list box

Sets the bus width of the flash memory.

[Flash memory erasing
time] edit box*

Sets the TIMEOUT value at flash memory erasing. Increase the
value if erasing requires much time; the default time is three minutes.
The radix for the input value is decimal. It becomes hexadecimal by
adding H'.

[Entry point] group box

Sets the calling destination address of the write/erase module.

[All erasing module address] edit box: Inputs the calling destination
address of the erase module.

[Writing module address] edit box: Inputs the calling destination
address of the write module.

Note: Although the values that can be set are D'0 to D'65535, the TIMEOUT hours may be
extended according to the set value. Therefore, it is recommended to input the minimum
value. The value to be input must only be positive integer.

O Notes on using the flash memory download function
The following are notes on downloading to the flash memory.
*  When the flash memory download is enabled, downloading other than to the flash memory

areaisdisabled.

» Downloading is only enabled to the flash memory area. Perform memory write or software
break only to the RAM area.

* When the flash memory erase is enabled, the [ Stop] button cannot stop erasing.
* Theareafor the write/erase module must be MM U-disabled space.
* Only the S-type-formatted file is enabled for the write/erase module.
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0 Examples of downloading to the flash memory

The following shows examples of downloading to the flash memory manufactured by Intel
Corporation (type number: G28F640J5-150) that has been mounted on Hitachi's SH7751
CPU board (type number: HS7751STCO1H). A sampleisprovided in the \Fmtool folder
in the installation destination folder. Create the program for user specification according to
thissample. The SH7751 E10A emulator must be used when the SH7751 CPU board is

used.

Table 3.8 Example of Board Specifications

Item

Contents

SDRAM address

H'0C000000 to H'OFFFFFFF

Flash memory address

H'01000000 to H'01FFFFFF

Bus width of flash memory 32 bits
Operating CPU internal frequency 167 MHz
environments Bus frequency 55.7 MHz
CPU internal module frequency  27.83 MHz
Endian Big endian
Flash memory SHXXXX
(32 Mbytes)
AO-A22 | FIA bus buffer A2-A24
CEQ |- FPGA Cs0
CE1,2 —— GND Cs2
OF [« FIA bus buffer RD
| WE [ WEO
D0-D7 o7 FD bus buffer - DO-D31
D8-D15[—
0007 |2 —@
D8-D15|—

DO-D7 <LQ

D8-D15 [—

D0-D7 |-223L

D8-D15|—

Figure 3.69 Flash Memory Wiring
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Table3.9 Sample Program Specifications

Item Contents

RAM area to be used H'0C001000 to H'0C0015BF
Write module start address H'0C001100

Erase module start address H'0C001000

(i) Sincethe SDRAM is used, the bus controller is set.

(ii) Options on the [Loading flash memory] page in the [Configuration] window are set as
follows:

Configuration

Gereral i Loading flazh memary |

Loading flash memary " Dizable {* Enable

Erazing flazh memory "~ Dizable {* | Enable

File name |G:¥HDI_CE¥fmtDDI¥FmtDDI.th Browse.. I
Buz width of flash memory IEE—I:uit huz width lI

Flazh memary erasing time |D'3 mirute

— Entry point

Bl erazing module address ||-|'|:||3|:||:|1 non

Witing module address |HOCO01100

(] 4 I Cance| | Sl | Help

Figure 3.70 [Loading flash memory] Page
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Notes: 1. When the data has already been written in the flash memory, be sure to select [Enable]
for [Erasing flash memory]. If [Disable] is selected, a verify error occurs.

2. When [Erasing flash memory] is selected, it takes about one minute.

(iii) [Load Program...] is selected from the [File] menu for downloading to the flash
memory area
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3.23 What Next?
Thistutorial has described the mgjor features of the emulator and the use of the HDI.

Sophisticated debugging can be carried out by using the emulation functions that the emulator
offers. This providesfor effective investigation of hardware and software problems by accurately
isolating and identifying the conditions under which such problems arise.

Further details on the use of the HDI can be found in the separately issued Hitachi Debugging
Interface User's Manual.
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Section 4 Descriptions of Windows

4.1 HDI Windows

HDI window menu bars and the corresponding pull-down menus are listed in table 4.1. Wherea
description of amenu isincluded in the Hitachi Debugging Interface User's Manual or in this
manual, a O mark or the relevant section number is shown. Related commands in the E10A
Emulator User's Manual are also shown.

Table4.1 HDI Window Menus and Related Manual Entries

Hitachi
Debugging
Interface
Menu Bar Pull-Down Menu User's Manual This Manual

File menu New Session...

Load Session...

2.6

Save Session

Save Session As...

Load Program... 3.7.1

Initialize

Exit
Edit Menu Cut

Copy

Paste
Find...
Evaluate...

O 0O|0|0O|0O|0j0j0 0000
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Table4.1 HDI Window Menus and Related Manual Entries (cont)

Hitachi

Debugging

Interface This
Menu Bar  Pull-Down Menu User's Manual Manual

View Menu Breakpoints 3.11,3.17.1,4.2.4,6.5.5

Command Line

O
O
Disassembly... O —
I/O Area O —
Labels @] —
Locals O 3.16
Memory... O 3.12
Performance Analysis O —
Profile-List O 3.21
Profile-tree O 3.21
Registers O 3.9
Source... O 3.7.2
Stack Trace X 3.20
Status @] 3.10,3.17.1,4.2.9
Trace @] 427,653,657
Watch O 3.13
Run Menu Reset CPU O —
Go O 3.10
Reset Go O —
Go to Cursor O —
Set PC To Cursor O —
Run... O —
Step In O 3.14.1
Step Over O 3.14.3
Step Out O 3.14.2
Step... O —
Halt O —
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Table4.1 HDI Window Menus and Related Manual Entries (cont)

Menu Bar

Pull-Down Menu

Hitachi
Debugging
Interface
User's Manual

This Manual

Memory Menu

Refresh

Load

Save

Verify

Test

Fill

Copy

Compare

Setup Menu

Status bar

Options

Radix

Customise

Configure Platform...

Window Menu

Cascade

Tile

Arrange Icons

Close All

Help Menu

Index

Using Help

Search for Help on

About HDI

O/ O|0O/0O 000 0000000000000 o
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4.2 Descriptions of Each Window

This section describes each window. Figuresin this section are used as examples. Each E10A
emulator type has explanatory notes. Read section 6, SHxxxx E10A Emulator Specifications.

42.1 [Configuration] Dialog Box
Function:
This dialog box sets the emulation conditions of the emulator.

Window:

Configuration |

General | Loading flash memory |

Mode M

Emulation mode IN-:nrmaI j
Step optioh IDisaI:uIes interrupts during single step e:-:eu:utiu:unj
UBC mode [Em [

Memory area & Momal ' Phesical © Witual 2510 ID'I:I

AD clock [1/8 CPU clock =l

JTAG clock [4.125MH2 =]

Ciriver: Change... |
k. I Cancel | e 1 | Help |

Figure4.1 [Configuration] Dialog Box

Note: Theitemsthat can be set in thiswindow differ according to the product. For the
settings for each product, refer to the online help.
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Description:
The [Configuration] dialog box consists of the [General] page listed in table 4.2.

Table4.2 [Configuration] Dialog Box Page

Page Name Description
[General] Sets and displays the emulation mode conditions.
[Loading flash memory] Sets the download function for the flash memory.

Clicking the [OK] button sets the emulation conditions. If the [Cancel] button is clicked, this
dialog box is closed without setting the emulation conditions.
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(1) [General] Page ([Configuration] Dialog Box)
Function:

This page sets the emulator operation conditions, displays the device name, sets the emulation
mode, UBC mode, and memory area (only for a product that supports a device with the MMU
function), sets and displaysthe AUD clock (AUDCK) and JTAG clock (TCK), and selects the
driver.

Window:

Configuration |

General | Loading flash memory |

ade T

Emulation mode IN-:nrmaI j
Step optioh IDisaI:uIes interrupts during single step e:-:eu:utiu:unj
UBC mode [Em I

Memory area & Momal ' Phesical © Witual 2510 ID'I:I

AD clock [1/8 CPU clock =l

JTAG clock [4.125MH2 =]

Ciriver: Change... |
k. I Cancel | e 1 | Help |

Figure4.2 [General] Page ([Configuration] Dialog Box)

Note: Theitemsand displayed contentsthat can be set in thiswindow differ according to
the product. For the settingsfor each product, refer to the online help.
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Description:

Table4.3 [General] Page Options

Option

Description

[Mode] combo box

Displays the device name.

[Emulation mode] combo box

Selects the execution mode. Select Normal to perform normal
emulation. Select No Break to disable breakpoint settings.
Select Sequential break Condition 2-1, etc. to use the sequential
break function™. (For Sequential break Condition 2-1, execution
stops when conditions are satisfied in the order of Break
Condition 2 and Break Condition 1.)

[Step option] combo box

Enables or disables interrupts during step execution.

Disables interrupts during single step execution: Interrupts during
step execution are masked.
Enables interrupts during single step execution: Interrupts during
step execution are released.

[UBC mode] combo box

EML: The UBC is used as a Break Condition by the emulator.

USER: The UBC is released for users. In this case, the [Break
Condition] page becomes non-active.

[Memory area] group box

Sets the address setting mode to the memory area.

The default is Normal. When the VP_MAP is enabled and the
address is within the table range, address translation is done
according to the VP_MAP table. For other cases, address
translation is done according to the MMU state.

Select Physical when setting with a physical address. Select
Virtual when address translation is done by the TLB table.

[AUD clock] combo box

Selects the AUD clock®.

[JTAG clock] combo box

Sets the JTAG frequency”.

[Driver] group box

Displays the driver currently selected.

[Change...] button

Displays the [E10A Driver Details] dialog box. Use when a driver
currently connected is changed.

Notes: 1. When usin